## CONTENT CREATION TOOLS

<table>
<thead>
<tr>
<th>UNIT</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Communicating with Graphics</td>
<td>7</td>
</tr>
<tr>
<td>12</td>
<td>Digital Audio</td>
<td>39</td>
</tr>
<tr>
<td>13</td>
<td>Digital Video</td>
<td>51</td>
</tr>
<tr>
<td>14</td>
<td>Interactive Multimedia</td>
<td>73</td>
</tr>
<tr>
<td>15</td>
<td>Creating Materials for the Web</td>
<td>93</td>
</tr>
</tbody>
</table>
# MDE-418: Educational Communication Technologies

*(New Course in place of ES-318: Communication Technologies for Distance Education)*

## EXPERT COMMITTEE

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>Institution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prof. A. Sukumaran Nair</td>
<td>Chairman</td>
<td>Former Vice Chancellor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mahatma Gandhi University</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kottayam</td>
</tr>
<tr>
<td>Prof. O.S. Dewal</td>
<td>Former Founding Director</td>
<td>National Open School, New Delhi</td>
</tr>
<tr>
<td>Prof. K. Sudha Rao</td>
<td>National University of Educational Planning and Administration, New Delhi</td>
<td></td>
</tr>
<tr>
<td>Prof. Chandra Bhusan</td>
<td>Formerly CIET, National Council for Educational Research and Training New Delhi</td>
<td></td>
</tr>
<tr>
<td>Prof. Santosh Panda</td>
<td>Director</td>
<td>Staff Training and Research Institute of Distance Education IGNOU, New Delhi</td>
</tr>
<tr>
<td></td>
<td>(Convener)</td>
<td></td>
</tr>
</tbody>
</table>

**STRIDE Faculty**

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>Institution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prof. K. Murugan</td>
<td>Director of School of Humanities</td>
<td>Tamil Nadu State Open University</td>
</tr>
<tr>
<td>Prof. S.V.S. Chaudhary</td>
<td>School of Education</td>
<td>IGNOU, New Delhi</td>
</tr>
<tr>
<td>Prof. P.R. Ramanujam</td>
<td>Prof. C.R.K. Murthy</td>
<td>Prof. Madhu Parhar</td>
</tr>
<tr>
<td>Prof. Basanti Pradhan</td>
<td>Prof. P.K. Biswas</td>
<td>Dr. Sanjaya Mishra</td>
</tr>
<tr>
<td>Dr. Sanjaya Mishra</td>
<td>Dr. Ashok K. Gaba (Now with SOVET, IGNOU)</td>
<td></td>
</tr>
<tr>
<td>Ms. Mythili G.</td>
<td>Ms. Mythili G.</td>
<td>Mr. Tata Ramakrishna</td>
</tr>
<tr>
<td>Dr. Rose Nemiakkim</td>
<td></td>
<td>Dr. Satya Sundar Sethy (on lien)</td>
</tr>
</tbody>
</table>

## COURSE TEAM

### Course Contributors

- **Prof. Rajaram Sharma**
  - Unit 11, 13 & 15
  - CIET, NCERT, New Delhi
- **Prof. Anurag Saxena**
  - Unit 12
  - SOMS, IGNOU, New Delhi
- **Dr. Jaayshree Shinde**
  - Unit 14
  - SNDT Women's University, Mumbai

### Course Coordination

- **Dr. Sanjaya Mishra**
  - STRIDE, IGNOU, New Delhi

### Content, Format, & Language Editor

- **Dr. Sanjaya Mishra**
  - STRIDE, IGNOU, New Delhi

## PRINT PRODUCTION

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>Institution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ms. Promila Soni</td>
<td>Section Officer (Publications)</td>
<td>STRIDE, IGNOU, New Delhi</td>
</tr>
<tr>
<td>Mr. Sunil Kumar</td>
<td>Section Officer (Publications)</td>
<td>STRIDE, IGNOU, New Delhi</td>
</tr>
</tbody>
</table>

October, 2010
© Indira Gandhi National Open University, 2010
ISBN-978-81-266-4877-1

All rights reserved. No part of this work may be reproduced in any form, by mimeograph or any other means, without permission in writing from the Indira Gandhi National Open University.

Further information about the Indira Gandhi National Open University Courses may be obtained form the University office at Maidan Garhi, New Delhi - 110 068.

Published by **Prof. Basanti Pradhan**, Director, Staff Training and Research Institute of Distance Education (STRIDE), IGNOU, New Delhi on behalf of the Indira Gandhi National Open University, New Delhi.

Cover design by M/s. ADA Graphics, New Delhi


Printed at: Public Printing (Delhi) Service
# MDE-418: Educational Communication Technologies

## Course Outline

### Block 1: Communication Technology: Basics

<table>
<thead>
<tr>
<th>Unit</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to Communication Technology</td>
</tr>
<tr>
<td>2</td>
<td>Communication Networks</td>
</tr>
<tr>
<td>3</td>
<td>Pedagogical Designs for Communication Technology</td>
</tr>
<tr>
<td>4</td>
<td>Managing Technological Change</td>
</tr>
<tr>
<td>5</td>
<td>Student Assessment in Technology Enhanced Learning and Evaluation of Technology</td>
</tr>
</tbody>
</table>

### Block 2: Technology Primer

<table>
<thead>
<tr>
<th>Unit</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Radio and Audio</td>
</tr>
<tr>
<td>7</td>
<td>Television and Video</td>
</tr>
<tr>
<td>8</td>
<td>Satellite-based Education</td>
</tr>
<tr>
<td>9</td>
<td>E-Learning</td>
</tr>
<tr>
<td>10</td>
<td>M-Learning</td>
</tr>
</tbody>
</table>

### Block 3: Content Creation Tools

<table>
<thead>
<tr>
<th>Unit</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Communicating with Graphics</td>
</tr>
<tr>
<td>12</td>
<td>Digital Audio</td>
</tr>
<tr>
<td>13</td>
<td>Digital Video</td>
</tr>
<tr>
<td>14</td>
<td>Interactive Multimedia</td>
</tr>
<tr>
<td>15</td>
<td>Creating Materials for the Web</td>
</tr>
</tbody>
</table>

### Block 4: Interactive Delivery Methods

<table>
<thead>
<tr>
<th>Unit</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Email, Mailing Lists, Discussion Groups, RSS Feed</td>
</tr>
<tr>
<td>17</td>
<td>Web 2.0</td>
</tr>
<tr>
<td>18</td>
<td>Virtual Classroom and Virtual Reality</td>
</tr>
<tr>
<td>19</td>
<td>Reusable Learning Objects</td>
</tr>
<tr>
<td>20</td>
<td>Learning Management Systems</td>
</tr>
</tbody>
</table>

### Block 5: Learning Portfolio
INTRODUCTION TO THE COURSE

In the previous courses you have studied that distance education is primarily a technology mediated system of teaching and learning. Media (especially electronic media) plays a significant role in the delivery of educational opportunities to people who need education at their door-step, study at their own pace, time and place. Educator’s tryst with technology has been a story of evolution of the media itself. Starting from the use of blackboard and the printed textbook for mass education, educators have always experimented with the use of technologies to improve their teaching and learning at all levels. With the emergence of a variety of Computer and Communication Technologies, the process of adoption and adaptation of innovative technologies for the purposes of education and research has increased manifold. The use of technologies for teaching and learning has been broadly used as Educational Technology, which is the field concerned with the design, development, utilization, management, and evaluation of processes and resources for learning. The Association for Educational Communications and Technology (AECT) defined educational technology as “the study and ethical practice of facilitating learning and improving performance by creating, using, and managing appropriate technological processes and resources”¹. Historically the term educational technology has roots in audio-visual communication, systems approach, and educational technology as a process. In 1994, the AECT accepted ‘educational technology’ as synonymous with ‘instructional technology’. We use the title of the course as Educational Communication Technologies to discuss the use of a variety of technologies for educational communication purpose. We would like you to have an overview of the field, and we are sure your engagements in the course would lead to your further exploration of the field through reading further literature given as references in the units throughout the course.

Course Objectives
At the end of the course, you are expected to be able to:

- Critically examine the process of educational communication to plan, design and use appropriate communication technologies in context;
- Identify the range of educational communication technologies, and their relative strengths and weaknesses;
- Use educational communication technologies confidently to create digital content and deliver these through new information technologies;
- Discuss and explain the general trends in the developments and use of educational communication technologies at national and international level; and
- Create engaging, collaborative, reflective and authentic learning environments for delivery of education and training.

Though the course is theoretical in nature, it has a lot of practical components, and we expect you to use this course to develop skills of using the technologies discussed in the course. We expect you to develop independent learning abilities to use computers and other technical hardware to create learning resources and environments that are interesting, motivating and engaging to the learners. So, you may need access to computer and Internet at home, office or in a cybercafé to practice the ideas and skill related inputs given in the course.

We have also developed a short but interesting **Portfolio** that will give you instruction on how to practice the skill component, and record the outcomes. The portfolio shall be considered as the assignment component of the course and it would be evaluated at your study centre. You will submit the Portfolio at the study centre for evaluation after completing the activities mentioned there. You may like to discuss these activities in the counselling sessions with the available counsellor, who is trained to guide you to accomplish the tasks of the course. He/she will evaluate your engagements in the course through what you present in the portfolio.

There are **Check Your Progress** questions spread over in the course, and we expect you to do these before you actually check for the feedback given at the end of the units. These are opportunity for you to assess your own progress. These are places where you take pause in reading, and think, do, write, discuss and compare your answer with that of the one given at the end. If you check the response before you actually do the task, it would be cheating yourself, and we are sure you will not prefer to do so. If your response is different than the one given in the feedback, we advise you to re-check your own conceptions and thinking about the question/issue and read the topic again.

You may also like to highlight such areas for discussion in the **Counselling** sessions. Your interaction in the counselling session would make it more meaningful and lively. Counselling sessions are also the time when you can meet other learners, and see the diverse nature of the learner profile. It is encouraging to meet people with diverse background reading same subject and discussing and sharing ideas discussed in the course. If your learning style is more towards discussion and interaction, I suggest you must attend the counselling session. Even if, you are shy and like to study on your own through the materials supplied, counselling sessions provide you information about further readings and appraise you of the latest developments in the field. There is so much to learn from others, who are also seriously engaged in learning the same subject. Personally, I have benefited a lot by attending the counselling sessions, when I studied through distance mode.

Besides the counselling sessions, there are other media materials, and services available in this course, and you may like to take advantages of these by attending the teleconference session/virtual class as and when conducted. You will receive information about special arrangements regarding this from time to time.

**What is covered in this Block?**
In the previous blocks of this course, you have studied basics of communication technologies (Block 1), and introduction to different media and technologies (Block 2) used in teaching and learning. In this block, we will learn about the use of content creation tools. Thus, essentially this block is more practical oriented than the previous two blocks. It is expected that you have access to a computer with relevant software tools to practice and learn. We introduce the software to you, and provide the basics to handle it. Your continuous practice will make you develop mastery over the software. However, it may be noted that the primary objective is to help to understand what can be done with these software, and how you can do it yourself without dependence on computer professionals.
In Unit 11, we present to you the importance of graphics for instruction, and illustrate the use of graphics design tools such as **OpenOffice.org Draw** and **Impress**, **GIMP** and **Picasa**. In Unit 12, we discuss creation and use of digital audio using **Audacity**. Unit 13 presents to you the basics of video and video capturing and editing using **MovieMaker** and other web-based tools. In Unit 14, we turn to interactive multimedia and present an overview of the use of multimedia in teaching and learning without going into the details of specific multimedia development software. Our approach has been to help you understand the intricacies of multimedia script and storyboard development in the context of theoretical underpinnings of multimedia for learning. In Unit 15, we describe material creation for the World Wide Web (WWW), and illustrate this with the use of **NVU HTML Editor**.

As indicated earlier, you need to have access to computer with relevant software, and therefore, we list the required software here. You can download these from the Internet:

- OpenOffice.org (Download from http://download.openoffice.org/)
- NVU (Download from http://net2.com/nvu/download.html)
- GIMP (Download from http://www.gimp.org/downloads/)
- Picasa (Download from http://picasa.google.com/)
A picture is worth a thousand words! Be it a graph, a drawing, a map, or a photograph, it is possible for us to pack a lot of information in to it. We use the word Graphics for any of these visual representations of information. You would have observed that books, newspapers and magazines are increasingly using graphics to communicate. With the aid of computer software, graphics have evolved into a very powerful and sophisticated means of visual communication.

Observe a graphic in a newspaper – say a bar chart or graph in the economics section, or a cartoon. Compare this with the cover of a glossy magazine. In what ways does this limit the ability to communicate? Make a collection of different graphics and analyse them. For what purposes would you use each kind of graphic? Are some types more suited for particular kinds of communication?

Television and computer animation have combined to add yet another dimension to graphics – motion. A simple graph, where the curve or the bar grows to depict an increase in the quantity, makes the visual representation more appealing. How does combining motion with graphics help enhance communication? Observe different motion graphics and analyse them. For what purposes would you prefer motion graphics?
Graphics are used not only to communicate information, but also as decorative elements (borders, boxes, corners ...) to embellish the message. Greeting or Invitation Cards, Posters or Notices, Covers of Books, Web Pages or logos – you will find hundreds of examples of graphic elements in use.

Lines and curves, colours, light and shade, lettering (font, type size and highlighting) are the different elements, a graphic is made of, each element having a definite purpose in the communication. While there are no rules for what elements should be used in what combination for what effect, a general sense of aesthetic appeal (it is pleasing to the eye) will help you decide. Moreover, different people have preferences for different colours and different designs. If you observe traditional graphic forms, different cultures have different motifs and designs.

In this unit we will examine graphics, analyse its use, learn to generate graphics using different computer software, and use them as a part of different types of communication. In the process, we will also learn about colour and design.

11.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:

• Identify different types of graphics and graphic formats;
• Describe the principles of graphic design;
• Use graphic design tools to communicate concepts and ideas; and
• Use concept mapping tools.

11.2 GRAPHICS IN INSTRUCTION

Graphics, as we mentioned earlier is a technique of visually representing information, where with the use of various graphic elements, the message is highlighted. It is expected to draw and hold the attention of the viewer. The message itself is represented in ways that modifies the perspective, links it with other popular events, images or styles, distorts particular aspects so as to highlight it and makes it funny, and so on. We also mentioned that graphics are used for decorative purposes. Most posters and banners have the purpose of advertising a message and use graphics to enhance communication.

How are graphics used in instruction? How will its use be different? Let us examine two possible uses of graphics – one in printed materials like textbooks; two as a teaching aid, either as a projected slide or as a web page, say a part of an online learning package. In the following discussion, we will restrict ourselves to these two uses only.

11.2.1 Use of Graphics in Printed Instructional Materials

Traditionally, one would encounter only a few types of graphics in textbooks. One would find diagrams (say in a biology text) or pictorial representations of models (say in a chemistry or geometry text), maps (say in a geography text), graphs (say in algebra or physics texts) or flow charts. Occasionally, some authors may prefer a comic strip or a cartoon. Let us examine each of these types of graphics in order to understand their characteristics.

Diagrams are generally a simplified version of the real thing. For instance a diagram of say the circulatory system in the human body may only contain
the heart connected to a few bunches of arteries and veins (Figure. 11.1). Depending on the specific purpose of this graphic, details would be highlighted. For instance, if the purpose was to show the process of circulation, then perhaps the different sections of the heart would be shown in a cutaway of the heart. The graphic would be labelled. Again depending on the age of the potential viewer, or the depth to which the content is elaborated, the labels would be in simple English or loaded with jargon.

**Figure 11.1: A schematic diagram of the human circulatory system**

Diagrams can range from very simple line drawings to very elaborate coloured three-dimensional drawings. Labelling may also range from simple to complex. The rule of thumb for a good diagram is the match between the specific purpose of the diagram, the level of the viewer and the complexity of the subject matter. Compare the diagrams of a cell in a middle school science textbook and a textbook of physiology used by students of medicine. How are they different?

**Maps** are a specialised form of graphic. Usually used to represent a geographical region, they can also be used to present a variety of information relating to that geographical region. For instance, you can have a map depicting roads connecting different places in a country or the religions practised in different parts of that country or the location of tourist attractions or the crops grown in different parts of the country or even the weather pattern across that country. The distinguishing characteristic of a map is that it is a scaled down version of the real thing – the ground.

What makes a map an effective graphical communication? If the map is a physical map of a region, it will depict the relative elevations, the differences in vegetation, water bodies (perhaps even the depths), and the locations of many important places. Obviously it would not be advisable to depict all the possible information on it. That would make it impossible to decipher. Avoiding clutter or information overload, use of colour such that different features are distinguishable and clear coding (use of icons, colour codes, symbols, etc.) to facilitate easy retrieval of information are the hallmarks of a good map. Study a range of maps and check to what extent they meet these criteria. How could you have made it more effective?
**Graphs** are also a specialised form of graphic, specifically used for making comparisons of quantities. Pie charts, X-Y graphs, bar charts, etc. are different forms of visual representation of relationships between the quantities being compared. Let us take the case of an X-Y graph (Figure 11.2). This is a typical case of representing what happens to quantity Y, while X increases or decreases. For example, you could represent the change in speed of a vehicle with time. So you have time represented on the horizontal (x-axis) and the speed on the vertical (y-axis). The jagged line on the graph permits us to read the speed at any given point in time. You also observe that both the x and the y axis have a scale, which makes the readings exact.

![Figure 11.2: A speed time plot](image)

What are the characteristics of this graph that makes it effective as a graphic? A clear title or caption, indicating the purpose of this graph, the appropriateness of the scale (all data points fit into the scale; data points do not crowd, making it difficult to read), scale clearly marked (e.g. y-axis: 1cm = 10 kmph) and legends and axis labels marked indicating what quantities are depicted.

**Flow charts** are used to represent a process or an algorithm. Each of the steps are displayed in boxes the process and the sequence indicated by arrows connecting these boxes. Represented this way, it helps the reader easily figure out the complete sequence of events and their relationships. Similar in function to a circuit diagram, it also helps in analyzing or managing a process. It can be of great help in troubleshooting (finding errors and attributing reasons for them), like in the case of a faulty computer programme. A particular kind of flow chart, called an organisational chart or organogram is used to represent the hierarchical relationship between various offices or officers within an organisation (Figure 11.3).

What should the characteristics of a flow chart be? Obviously, the reader should be able to see all the steps clearly, identify their relationships, and identify the sequence of events. If there are different categories of steps or relationships, one may resort to colour coding or using different types of boxes.
11.2.2 Appropriate Use of Graphics

Graphics, you would have observed is an economical and visually enriching style of communication. But inappropriate use would distract or even lead to miscommunication. While using graphics you could work with a few thumb rules. Remember, none of these are sacrosanct, but will aid effective communication.

- Identify the particular type of graphic suited to the purpose of communication;
- Select a style which clearly highlights the information;
- Size of the graphic should be proportionate to the importance of the information - very small or very huge graphics may not serve your purpose;
- Titles, captions, labels, legends, icons, and other markers should be legible, suitably located, proportionately sized and of an appropriate colour and font.
- Use of decorative elements – colours, patterns, borders, shadows or stylised fonts – should be carefully selected to aid communication.

Computer graphics software provides too many choices and very elaborate and purely cosmetic elements. These may not be very helpful for instruction. Discretion in use is very essential.

Check Your Progress 11.1

Notes: a) Write your answer in the space given below.
    b) Compare your answer with the one given at the end of this unit.

What types of graphics will you use and the feature to highlight the following example?

a) A discussion on the fuel crises
b) A report on votes polled by different parties in an election
c) A building plan

........................................................................................................................................
........................................................................................................................................
........................................................................................................................................
........................................................................................................................................
11.3 GRAPHICS FILE FORMATS

Now-a-days almost all of printing and video tasks are accomplished by computer software applications. While introducing you to the details of these software or their use is beyond the scope of this unit, it would certainly be helpful if you are familiar with the basics of computer graphics. Computers handle digital data. They can process numbers, very rapidly, very reliably, and tirelessly. Computer scientists have succeeded in employing these capabilities to help computers process images. Again we will not be able to describe these in detail, but we will try to give you an overview.

The screen of a computer monitor (or display unit) displays the graphic to us. Imagine a large number of horizontal and vertical lines crossing each other dividing the rectangular screen into a very large number of tiny squares. To give you an idea of how many such squares are used, do the following:

• Right-click anywhere on your computer desktop (minimize all windows before you do this) and select properties from the pop-up menu;
• Select the settings tab;
• Observe the numbers in the section titled screen-resolution;

You will see a number, such as 1024 × 768 or 1280 × 1024 or 800 × 600 (in older computers). What does this mean? The number 1024 × 768 means that your screen is divided into 786432 squares (the product of 1024 verticals and 768 horizontals). Each of these small squares is called a pixel (meaning picture element). So each pixel can be considered the smallest unit of an image. Each pixel carries information about the colour and opacity of a particular part of the image. Together, all the pixels arranged in a rectangular grid help generate the graphic, which we see on the monitor (see Figure 11.4).

If the number of such pixels is increased (or alternately, the size of each pixel is reduced and pixels packed together) the image becomes sharper and more detailed.

11.3.1 Vector and Raster Graphics

The way the computer generates these images leads to two broad categories of graphics, rasters and vectors, which we will consider now.
Television and Computer screens are of different kinds. The most common being the Cathode Ray Tube. Increasingly these are being replaced by LCD and LED displays. In order to display an image, the Cathode Ray Tube (or CRT) would scan the ray across the screen, move one step down and scan the screen again, rapidly covering the entire screen (see Figure 11.5). These scan lines were referred to as rasters. The computer broke the image into thousands of pixels, lined them up in the sequence in which the monitor scanned the screen and using this principle, the CRT displayed them in that order.

![Figure 11.5: Scanning process in a cathode ray tube monitor](image)

What information should each of these pixels contain? Obviously, information about the colour to be displayed as well as information about its opacity (without this the image would appear flat). This process of converting an image into a sequence of pixels is referred to as rasterisation and the image so generated called a raster image.

Remember that the computer actually stores numbers made up of zeros and ones. So each pixel is actually a series of numbers representing the colours and opacity. Each number is a bit and a pixel therefore, is a map of that series of numbers. A raster image is therefore also referred to as a bitmap.

Yet another process by which computers understand images is by breaking down the image into lines and curves, related to each other by mathematical equations. We refer to these as vector images.

For our purpose, it suffices to know that bitmaps or raster graphics are commonly used to represent photographs, and vectors are preferred where line drawings are used. While both types can be used for all kinds of images, they lead to very different file sizes and depending on the purpose, the choice becomes obvious. One other major difference between these two types appear when you scale the image (increase or decrease its size). While a vector graphic retains its quality, the raster image breaks down into small squares, losing all its detail (see Figure 11.6).
11.3.2 Comparison of File Formats

Using either rasters or vectors, computer graphics software generate and save graphics in a variety of file formats. Each of these formats have been evolved with a specific kind of output in mind. We will examine a few of the commonly used formats and compare their characteristics.

If you are familiar with the naming of computer files, you will know that the file extension (the latter part of a file name, e.g. .bmp, .jpg) is the easiest way of recognising the file format. Each such file extension represents a set of rules governing the encoding and decoding of information. The commonly used raster or bitmap graphic file formats are .bmp, .gif, .jpg, .png, .tiff, .tga; commonly used vector graphic file formats are .svg, and .pct. Most computer graphic software use their own special file formats, allowing them to retain more information. For instance .cdr is the vector graphic format used by Corel Draw®, while .psd is the raster format used by Adobe Photoshop®.

For the purpose of this section, we will use the Free and Open Source software GIMP. You could also use any other image editing software like Adobe’s Photoshop®, Corel’s Photopaint®, etc. Start with a graphic of your choice. You could start with a photograph or a line drawing, a map or a graph. If the graphic was already on your computer, note down the file format and the file size. Open the file in the image editing software. Save a copy of this file (use Save As or Save a Copy). In the option available for selection of file format, choose GIF (.gif). Save the file (See Figure 11.7). Repeat this process saving the file as JPG (.jpg), BMP (.bmp) and PNG (.png). Now you have four copies of the same file. What differences do you expect between each of these files? Open the folder in a new window and switch to Details View. Observe the column where file sizes are listed. What differences do you observe? Remember, you have four different files containing the same graphic. Which format gives you the smallest file size? Which format gives the largest file size? (see Figure 11.8).
Open all the four files in your image editing software and place them side by side. Do they look alike? Are they different? How? You will also observe there are differences in the quality of the image. Use the zoom tool to expand each of these images, say to 400%. What do you observe?

Each image format has been specifically designed to meet particular requirements. For instance, GIF or Graphics Interchange Format has been designed for web-based graphics. It reduces the file size by using a colour palette that contains a limited number of colours. It can handle a maximum of 256 colours. Typically the GIF format is used for small graphic elements.
like logos, decorated text, or small animations, where the number of colours and variations in shades are minimum. If the image you chose is a photograph with a variety of shades, you will notice that the GIF format loses a lot of information. The GIF format can store a sequence of images and play them out as an animation.

The JPEG (Joint Photographic Experts Group) or JPG format also compresses files, making them small. But it loses information while compressing. We refer to this as a lossy compression. This format is preferred for saving photographs as it provides a range of saving options to balance the compression of the image size compared to image quality. If you zoom into a jpg image, you will notice the losses in information. Surprisingly, each time you save a file as JPG, it is recompressed losing more detail. So it is best to keep the original image and make a fresh JPG each time. Overall, if you want to compress a continuous-tone image, JPEG is the way to go. It is not ideal for saving line drawings, high-contrast pictures.

The BMP, otherwise known as Windows Bitmap, is a file format specific to Windows. BMP is actually the native file format for Microsoft® Paint. This format supports files containing up to 16 million colors. It also saves your documents using RLE (Run-Length Encoding), which is a lossless compression. What does that mean? Basically, when you save your file using a lossless format, it takes the file and condenses the information so that it takes up less disk space while retaining all of the image data. Notice that this format should have yielded the largest file size.

PNG, pronounced as “ping” (Portable Network Graphics) files are also designed for the Web. They can work with up to 16 million colors. This format supports RGB, indexed color and grayscale imagery. It even gets rid of those little artifacts associated with JPEGs. Some of the older browsers may require a plug-in to display .png files correctly.

### 11.4 MOTION GRAPHICS AND ANIMATION

Animation is a technique of displaying a collection of images, in a sequence, so as to simulate a moving scene. In fact cinema itself uses this technique. If you happen to physically view a portion of a film reel, you will notice that each frame is a snapshot of a particular instant. And every subsequent frame is similarly a snapshot of the event a little later than the preceding frame and a little before the succeeding frame. All of your favourite cartoons are made this way.

#### 11.4.1 Animation using Computer Software

Computer software specifically designed to aid such animation have the ability to combine and playback such image sequences. But remember, that the software itself can do very little. The visualisation and generation of the images will have to be done by you. Some software have the capability to ‘tween’, that is to generate the in between images when you define the start and end points. But for this to happen, the software should be able to compute the sequence of changes. Generally, physically moving an object across the screen, of growing it, or changing its colour or a combination of these can be easily achieved mathematically.

Some very sophisticated modelling and animation effects are achieved using such software. In fact, animation has grown into a very large industry world
wide and is in great demand, particularly for the film and advertising industry. For our purposes, motion graphics and animation would have two purposes. One, to use effects aimed at highlighting information and two to communicate concepts involving changes in space and time. Let us consider a few typical examples and the techniques of achieving this.

Slides shows are a common technique of making presentations. Many of you would be familiar with Microsoft Power Point®. In fact every Office suite of software consists of a presentation application. Two kinds of animation effects are used here. One, where elements on a slide move; perhaps you have a set of bulleted points you wish to reveal one at a time, as your lecture progresses. Such effects can be used for progressively labelling a diagram, highlighting some part of the slide, say image or text, by changing its font, colour or moving it, or for actually plotting a graph as you describe the changes. Two, when you move from one slide to another, the previous slide gets replaced by the current slide through an effect. We refer to this as a transition. These transitions of course may not have any educational importance, and is mainly used as a decorative eye catcher.

Making an elaborate visual communication of a process, say how a petrol engine functions, would require very elaborate graphics and animation. This would not only require detailed drawing tools but also tools to animate different parts of the object and combine them together on a time line. One very commonly used software application for such animation is Adobe Flash®. This software is a vector graphics application and can be used to develop very sophisticated multi-layer drawings. It also has a time-line on which you assemble the scenes into a complete movie, supporting it with different kinds of effects and transitions. You can also associate the scenes with an audio recording, say music or a commentary. The output could be in the form of a gif animation, an image sequence, a movie file (*.avi) or a shockwave file (*.swf). Recent versions of Flash also export to formats suitable for playing movies over the Internet. The animation so produced can run independently and can also have interactions built into it. This latter feature is particularly suitable for making interactive multimedia packages.

There are of course a large number of software applications used for two dimensional and three dimensional models and animations. Some of these are very sophisticated and are even used to make digital effects for movies.

11.4.2 GIF Animation

As we mentioned earlier, the GIF format is capable of playing out a sequence of images one after another in a pre-specified speed. This allows us to depict transitions – say a rotating logo, an animated border or line or a slide show. Given the limitations of the file format itself, this feature is no more used extensively. Most graphic software like GIMP, Adobe ImageReady, Corel PhotoPaint allow you to save a sequence of images as an animated GIF file.

11.5 COLOUR THEORY

Colour is among the most fascinating aspects of nature and it has been humankind’s endeavour, not only to understand it, but also to learn to mimic it in their works. The human eye is equipped with two kinds of sensors, one which recognises brightness and the other which senses colour. It would be interesting to note, that not all animals are equipped with this capability.
When we recognise something as coloured, let us say, green leaves, we are simultaneously recognising a number of things. Not all leaves look the same colour. So there is something about the greenness of it. The same leaf would look different in broad daylight, as compared to dawn or dusk, when lit up or when in the shade. If the rising or setting sun glow red, the leaf would look different too. The colour of the light also has an effect on what our eyes perceive.

Through the ages, and particularly after Issac Newton established that white light is composed of seven distinct colours and invented the colour wheel, a large number of people have studied colour and tried to present theories about how colours are generated and perceived. While the issue is not clinched – there is still no final acceptable theory of colours, a variety of factors affecting colour have been identified, studied and understood.

For the purpose of our unit, it is not so important to understand the theory, but to explore some of the factors, in order to create the best possible graphic for the given medium – print or non-print.

As we mentioned earlier, there can be different pigments of slightly differing shades of the same colour – there can be many colours which go under a broad class called green. We also mentioned that the same shade of green would appear different under differently coloured light. In fact there are two broad categories of colouring material – paints and light. They behave differently too as we will find out shortly.

Colour theory recognises the existence of primary colours – colours which cannot be generated from other colours; and secondary colours – colours which can be generated by mixing different primary colours. While red, green and blue (RGB) are considered primary colours of light, magenta, yellow and cyan are considered primary colours for paint. They are also known as additive primaries and subtractive primaries respectively. Look at the figure below (Figure 11.9) showing mixing of primary colours that result in the secondary colours. Notice that when the three primaries for light are combined it results in white and the three primaries of paint together yield black.

Different combinations of particular primary and secondary colours yield other tertiary colours. But, this still doesn’t exhaust the range of colours we perceive.

What happens when you mix white and black? What happens when you mix white or black with a given colour? A pure color mixed with white is called a Tint. A pure color mixed with gray is called a Tone. A pure color mixed with black is called a Shade.
Imagine an equilateral triangle in which you have placed black at one of the vertices, white at another and a particular colour at the third vertex. Further imagine a gradation of colours between the vertices. For instance, if you use the Change Foreground/Background Color palette in GIMP and opt for the colour wheel (Figure 11.10) you can generate all the tints, tones and shades of that colour. Try this out, selecting different colours from the outside wheel in your computer.

Managing colours was a very critical function in the era of black and white television and cinema. Notice that two hues with the same tone would look identical in a black and white monitor. This would lead to effectively flattening and merging two characters, wearing dresses of the same tonal value. With the advent of colour television and cinema and with higher resolution, this is no more an issue.

Yet another way of distinguishing colours is through its hue, saturation and value. While hue refers to the particular colour – red, green, blue, brown, etc., saturation refers to its purity. Imagine a strong decoction of coffee. It would be of a deep brown colour. Now add milk to it, a little at a time, stirring up the mixture continuously. The brown fades each time. If you can add a very large quantity of milk, it would reach a stage, where it would look white. The third dimension, value refers to how bright the colour is. You can imagine a painted board in a room lit by a strong white light. Further, let us say, you have a mechanism through which you can progressively dim the light. What you perceive is the reduction of the value or the brightness of the colour. In the Change Colour Palette in GIMP, you also have sliders for Hue, Saturation and Value. Slide them and see the effect.

When we work with computer graphics using software like GIMP, we have access to an enormous range of colours, because of its ability to modify each of the factors minutely. The limiting factor is indeed the ability of our eyes to distinguish them as separate colours.
Many colours have names, for example you have a ruby red, a topaz green, or a prussian blue. Wikipedia (http://www.wikipedia.org) has a comprehensive write up on colours and their names. But obviously all the shades, tints and tones of a colour cannot be named. So computer software use a code, called the hexadecimal code (16 possible numbers, 1-9, 0, and a-f). This code represents each primary colour by a two digit code, thereby representing \(16 \times 16 = 256\) possible shades. So you have the possibility of \(256 \times 256 \times 256\), which is \(16,777,216\) colours. The hexadecimal code or the hex code for pure red is ff0000 (red=full/256, green=zero and blue=zero), pure green would be 00ff00 and pure blue would be 0000ff. Black would be 000000 and white ffffff.

**Check Your Progress 11.2**

**Notes:**

a) Write your answers in the space given below.

b) Compare your answers with those given at the end of this unit.

1) What are primary colours? Why do you think light and paints have different primary colours?

............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................

2) Are some colours more visible than others during sunset? How do you account for it?

............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................

3) Using a graphic software’s colour wheel, choose a primary colour palette, say blue. What is the closest shades of blue you can distinguish as separate colours?

............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................

4) What do you think is the utility of a hexadecimal code for colours?

............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
11.6 GRAPHIC DESIGN TOOLS

In this section, we will explore some common and free graphic design tools. While this cannot be a comprehensive tutorial on these tools, it will help you learn yourself to create simple graphics with them. Like with any software, the more you practise, the more familiar you will be with various capabilities of these tools.

11.6.1 OpenOffice.org Draw and Impress

OpenOffice.org, commonly known as Open Office is a suite of office applications, including a word processor (writer), a spreadsheet application (calc), a mathematics equation editor (math), a drawing application (draw), a presentation tool (impress), and a database application (base). Together, they form a powerful set of applications. The special feature of this suite is that it is a free and open source software and is tightly integrated, allowing the features of the separate applications to be used in each other.

In the following paragraphs, we will look at the features of two of these applications, viz., draw and impress.

Download and install OpenOffice.org. This suite is available for windows as well as linux operating systems. Most linux distributions will automatically install OpenOffice.org.

Open the application OpenOffice.org Draw. Before we actually use it, let us briefly look at the features of this application:

- OpenOffice.org Draw lets you create simple and complex drawings and export them.
- Draw allows insertion of tables, charts, formulas and other items created in OpenOffice.org programs into your drawings.
- Draw creates vector graphics using lines and curves defined by mathematical vectors.
- You can create simple 3D objects such as cubes, spheres, and cylinders in Draw and even modify the light source of the objects. Grids and guides provide a visual cue to help you align objects in your drawing.
- You can connect objects in Draw with connectors to show the relationship between objects. This is useful for creating organization charts and technical diagrams.
- Technical diagrams often show the dimensions of objects in the drawing. In OpenOffice.org Draw, you can use dimension lines to calculate and display linear dimensions.
- Draw includes a gallery containing images, animations, sounds and other items that you can insert and use in your drawings as well as other OpenOffice.org programs.
- Draw can export to many common graphic file formats, such as BMP, GIF, JPG, and PNG.

Let us create a simple process diagram in Draw, depicting the flow of energy in a typical food chain. Notice the drawing toolbar displayed at the bottom of the application window. If this is not visible, go to View ->Toolbars and select drawing.
Select any shape (the rectangle, ellipse, or from the basic shapes tools). You will observe a coloured shape on your page. You can change the colour by selecting a colour of your choice from the Area style/ filling option in the line and filling toolbar. Repeat this process to create four separate shapes (Figure 11.12).

Now arrange them on the page. When you click on any shape, handles appear, which allow you to resize them. Clicking inside the shape shows a cursor with four arrows pointing in four direction. You can now drag the shape to any place on the page. When selected, you can delete a shape too by pressing the delete button on your keyboard. A right-click will reveal a number of other options which you use to modify or reorganise your drawing. (See Figure 11.13).
Select the text tool on the drawing toolbar. Click inside a shape. Do you observe a textbox with a blinking cursor. Type a label to show meaning. Repeat this process with each of your shapes. (See Figure 11.14)

Select lines and arrows or connectors. Draw arrows or connectors to join the shapes according to the process flow.

Your diagram is complete. But notice, if you move any of your shapes, connectors or textboxes, the drawing will be disturbed. To ensure they behave as a single diagram, you need to group them. Select all the elements. You can do this by pressing Ctr+A, click dragging your mouse over the entire page or selecting Edit -> Select All. Observe the handles now define a rectangle covering all the elements. Right-click inside this region and select Group from the options. Test it by dragging any of the elements. Do all the elements move together? You can ungroup them anytime. You may also enter the group and exit it in order to modify any element. Once grouped, you can even copy the process diagram and paste it into any other application, as if it was a single object. Save your file.
Content Creation Tools

We have explored only one small feature of Draw. Play around with its various features and options, making different drawings to find out how powerful this application is.

Now we will explore OpenOffice.org Impress. This application allows you to make slide shows. As before, let us look at the features list before we proceed to make a presentation.

- OpenOffice.org Impress lets you create professional slide shows that can include charts, drawing objects, text, multimedia and a variety of other items.
- Many of the tools for creating vector graphics in Draw are available in Impress.
- Impress provides you with templates to create professional-looking slides. You can also assign a number of dynamic effects to your slides, including animation and transition effects.
- Impress also lets you rehearse the timing of your slide show. OpenOffice.org Impress gives you the choice of running a slide show automatically or manually.
- You can publish your slides on-screen, as handouts, or as HTML documents.

We will make a simple four slide, slide show. Each of our slides will contain a heading and a graphic. We will then insert transitions between slides and finally play it out as a slide show.

Open Impress in OpenOffice.org. Observe the panels on both sides of the work area. The left panel will show the four slides we will create. The right panel allows us to select a master design, a layout for the content on our slide, animations for the content, and slide transitions.

Let us select a layout, say with a title and a graphic. As soon as you select it, the slide in the work area acquires the layout. Click on the title bar and type in your title. Now double click on the icon in the graphic’s box. You will see a set of options for inserting a spreadsheet, chart, drawing, formula or text. If you want more options, select further objects and click OK. You will be shown a further set of options, which includes literally anything that can be
inserted including a video clip or a sound file. Let us select a bitmap image by clicking on Insert-> Picture-> From File (See Figure 11.16).

To insert the next slide, go to Insert -> Slide. A new slide with the same template appears on the screen. You will also see both the slides in the left panel. Alternately, you can also choose Insert -> Duplicate Slide. In this case, a copy of your slide is generated. Repeat this process two more times, generating four slides in all. Type in the titles in each of the slides. You may insert any of the objects we mentioned above – a drawing, a chart, a spreadsheet, or even a piece of text. Save your file.

Now we will apply transitions and convert the set of slides into a slide show. Transition is the effect which plays when a slide is displayed, for example a wipe, the second slide wipes out the first slide. Go to Slide Show -> Slide Transition...

Observe the new Slide Transition panel on the right with various options for the transition effects (Figure 11.17). You may choose to apply the same
transition to all slides or different ones to different slides, although the latter would be distracting. You can also define when and how the slide transits. Preview the effect you used. Once completed, you may run the slide show to preview your work. Go to Slide Show -> Slide Show.

There are a variety of slide layouts, transitions, animation effects, colours and textures that you can play around to make your slide show interesting. You may also like to publish your slide show on the web, or as a pdf document, or generate handouts. Do spend time exploring the various options, till you become familiar with the different tools offered by the application.

11.6.2 MS-Paint

Owing to the fact that this is a standard component of the Windows Operating System, most computer users have been introduced to it. In fact, many computer training programmes use MS Paint as a means to teach mouse control. This software application has a limited, but useful set of functions. We will explore a few of them and suggest that you try out the various features.

As its name suggests, MS Paint is a painting software. So what you are presented with are a canvas, a colour palette, brushes, a few text and shape tools. When you start this application, (go to start -> programs -> accessories -> paint) you begin with a blank canvas.

You may begin with the selection tool and define a shape. Paint within it or fill it. You may begin with a brush or pen (notice an options palette opens out below giving you choices for brushes). You may also begin with pre-defined shapes (rectangles, ovals and polygons). Notice the colour palette at the bottom. If you are not happy about the colour choice, go to Colors -> Edit Colors. If you click on Define Custom Colors, you will have a full choice of colours.
Remember, we said MS Paint provides a canvas. Once you put an object on it, that's it, you cannot select it and move or modify it. You can of course use the undo option (ctrl-z) to go back one step.

Using the text option along with shapes, you can create quite elaborate graphics. If you prefer the artist's way, you can paint your own picture. The images are saved in windows’ native graphic format, .bmp.

11.6.3 GIMP

GIMP stands for GNU Image Manipulation Program and is released under the GNU General Public Licence, which makes it a Free and Open Source software, giving you permission to freely use, distribute and even modify (if you know how to).

GIMP as its name suggests helps you manipulate images. You can start with a blank canvas and generate your own graphic, like you did with MS Paint. Or you can open a photograph or a scanned image and modify it. For a beginner, the sheer variety of tools and options can be intimidating. In fact, most software applications, even your word processor, have thousands of tools and options. Of these you use only a few to begin with. As you become more and more familiar and the tasks you attempt become more complicated, you will begin to use more and more tools and options.

![Figure 11.19: The GIMP interface](image)

In order to become familiar with the GIMP interface, we will attempt to make a poster. Let us identify the tasks we will have to undertake:

- Define the size of the poster
- Work out a rough design, including the background image, text, borders, etc.
- Implement the design in GIMP
- Ready the image for printing
While the printed posters we see are huge, one does not start off the design process with such a large canvas. We instead use a very high density (dpi) image, which finally is scaled up to the size desired without loss of quality. This is because every computer program needs memory, hard disk space and graphics processing capability and the larger the canvas size, more would be its requirement. Typically, very high resolution graphics, like say a photograph in a glossy magazine, is printed in 300 dpi or higher. Of course, that depends on the size of the canvas and the type of image information. A coloured rectangular band, for instance has no details and dpi hardly matters here, while a close up of a very colourful bird or a jungle scene is likely to have far more colour variation and would require a very high image density.

Let us define the size of our poster. Go to File -> New. A new window with the title Create New Image opens. You have options for setting the height and width of your image. Notice the pull down menu with pixels as the option. Pull it down to see other options. You may indicate your image size in pixels, inches, millimeters, etc. (See Figure 11.20). This is useful when you wish to make an image for the screen (pixels) or for print (inches / millimeters). For our purpose, let us define a size of 10 inches x 8 inches, a size just less than an A4 page and can be printed on almost all printers.

Also notice a button for Advanced Options. Click to open. Now you can also set the resolution (or image density) of your image in pixels/inch or / millimeter, etc. Set it to 72, the default value. Click OK. You now have a blank canvas to work with.

The second task is to freeze up your design. See Figure11.22, our final image. You can have your own design, with your own choice of colours. Now we will take you through the steps, generating this final image. In the process, you will explore various features of GIMP. Please note that software applications like GIMP are very complex and learning all its features would be quite time consuming. Our attempt here would only be to introduce you to a path, which will help you explore it on your own.
When you work with GIMP like software you need to become familiar with the concept of layers (Figure 11.21). Remember, when you worked with MS-Paint, if you erased something, all paint you applied on the canvas would be wiped out. This can be inconvenient if you wish to develop a graphic consisting of overlapping regions, for example, you might want a caption placed on a photograph, and would like to try out various colours or fonts for the text. Layers allow you to keep different elements separate and modify them independently. It would be like stacking many transparent canvases one above the other, each containing graphic elements. Using this, you can modify the elements as much as you wish, without affecting other elements. You can also apply special effects to particular layers or modify the properties. This gives us enormous flexibility in developing graphics. As you explore GIMP, you will also recognise a number of ways; layers can be used in increasing productivity and ease of working.

![Figure 11.21: The layers concept in GIMP](image)

Notice that GIMP opens with a canvas, a toolbox palette and a third palette, in which layers, channels, paths are listed. GIMP calls them dialogs, as they allow you to suggest options to the software. Click on the layers icon if the layers dialog is not on the top. Notice the buttons at the bottom of the dialog. You can create, delete layers from here.

First, let us insert a background image. Go to File -> Open and open an image of your choice. Let it be at least as big as your canvas. Remember, you can reduce the size of an image without loss in quality, but the same is not true for increasing it. The image opens in a new window. You may resize the image going to Image -> Scale Image and specifying the desired size (10x8). Go to Select -> All, and after selecting the image, go to Edit -> Copy and copy your image to the clipboard (the temporary space where windows stores copied information). Click on the blank canvas we opened earlier. Go to Edit -> Paste as -> New Layer. Notice, the image you copied is visible as a new layer.

Click on Create New Layer on the Layer dialog. You are asked to specify the size of the layer, allowing you a smaller layer than the original canvas. But for our purpose, we suggest you change the size to 10x8 and the layer fill type as transparency. Using the rectangle select tool from the toolbox, define
a rectangular region on the image, to function as a backdrop to the title you will be inserting in the next step. Click on the foreground colour and change it to a colour of your choice. Use the bucket fill tool from the toolbox and fill the selection. Use the opacity setting slider and set the opacity to 30%. Now you have a coloured rectangular backdrop. Use the move tool to position the rectangle at a location of your choice.

Now click on the text tool, write your image title. Notice that you can define the font, the letter size and the colour of the letters. Click close and you will find a new text layer. You can always edit this text or its properties by double clicking on the text. Use the move tool to position the text within the rectangle. Let us now add a special effect, say a drop shadow to the text. Go to Filters -> Light and Shadow -> Drop Shadow... A new window opens up with various options for the shadow. Make your selections and click OK to accept.

Save the image. Click File -> Save. Notice that GIMP assigns the extension .xcf to the file automatically. This format is GIMP’s native format and retains the layers information. If you wish to send this image for printing, or put it on the web, choose an appropriate file format. Click on Select by File Type to reveal other options in the Save window.

We have tried out a simple exercise in GIMP introducing you to some basic ideas of graphics software. Obviously for a creative individual, there are thousands of options available in the software. Do explore the different tools and options to generate or modify your graphics.

Figure 11.22: The final poster

11.6.4 Picasa

Once you have your collection of photographs and graphics, you would like a convenient way of organising and managing them. There are a number of software applications, which help you do so. Picasa from Google is one such free image management tool. What all can it do?
Once downloaded and installed, Picasa can look around your hard disk, map it and create albums and collections. It can create slideshows; make a movie from your collection, or even a collage. It can publish your collection to the web. If you have a photograph which needs correction, Picasa also provides some simple tools to do so.

Picasa also has a viewer application. When you open an image in this viewer, it is displayed along with a panel of thumbnails of all the images in that folder, and a set of tools for zooming, editing, navigating, uploading to the web, rotating, printing, and e-mailing. You can use the navigation button to go forwards or backwards, one image at a time, or run it as a slideshow.

Let us explore some of these features. Make a collection of images or graphics in a folder, say, the My Pictures folder. Open Picasa. You should see your images displayed as thumbnails in the right pane. In the left pane, you will find the folders containing the images listed. If you do not see some of the images on your hard disk displayed here, it is because you have not asked Picasa to look for it. Go to Tools -> Folder Manager... and select the folder(s), where you want Picasa to look. You can add description to your images here.

Select an image. Right click on it and select view and edit. The image is now displayed singly in the right pane. The left pane is replaced by a new one, with three tabs – basic fixes, tuning and effects. A number of options for correcting or modifying the image is available. Play around with it. Once you are done, you can click on back to library button above the left pane.
You can create albums containing select images. Go to File -> New Album and give it a name. Now you can select pictures, right click on them and add them to your albums. When you wish to publish this album on to a CD or a web album, Picasa will manage this activity for you.

Picasa has a large number of options for organising, managing, editing and publishing your image collections. You may like to explore these tools and become familiar with them.

11.6.5 Digitizing Graphics

Till now we have dealt with graphics generated on the computer or photographs already in the digital or electronic form (in the form of a computer file). In this section, we will consider how to import a printed graphic or document into a computer.

The process of converting any image into a computer readable file is referred to as digitisation. Now-a-days you have a number of very convenient devices to do this. The simplest of them is to use a web camera and save the image displayed on your screen. You could also use a digital still camera and upload the file from the camera on to the computer.

A scanner is a specialised device meant specifically for digitisation. The scanner consists of a camera like device which moves along the printed page, taking a continuous picture of the page, one strip at a time. The software then stitches up these strips into an image of the page. This is why the process is called scanning and the device a scanner. A photocopying machine is incidentally a scanner and printer combined.
Communicating with Graphics

Figure 11.25: A flatbed scanner

While scanning is a straightforward way of digitisation, it may result in changes in the image and you should know how to correct them.

If you use a camera, it is likely that the plane of the camera is not the same as the print you have digitised. This leads to a distortion (one edge smaller than the other, even when the original is a rectangle), which can be corrected using the perspective tool in software like GIMP.

Depending on the light conditions, changes in brightness or colour can happen. This again can be corrected with appropriate tools in software like GIMP or Picasa.

Scanners settings may be configured to yield an image, whose canvas size, image size or image density (dpi) may be different from the original. Depending on the purpose for which you are digitising it, you may have to reconfigure these settings in the scanner software. For example, if you want the image to be part of a book, which is to be printed, you may need a high resolution image, whereas, if you want it to be part of a website, a lower resolution image will suffice. You should also be aware of the graphic formats (discussed in section 11.3) you wish to work with and suitably convert (usually, save as) the digital image file.

11.7 TOOLS FOR CONCEPT MAPPING

A concept map is a chart depicting the relationships between concepts. It can be used as a way of organising your thoughts on a topic. At the same time, you could use it to communicate the topic to others. Concept maps have become quite popular with teachers using ICT tools, who use this not only for teaching-learning but also for evaluation.

In our context, we are looking at concept maps as a graphical representation of a subject / topic. Also we are interested in a software tool, which will help us make and present a concept map. One such free software is FreeMind, available from http://freemind.sourceforge.net. Download and install it.

Launch FreeMind and go to File -> New. You will be presented with a new canvas with your first node. Click inside to change the text inside. Now you can attach concept nodes to this. Remember, concepts can be at the same
level – two branches emerging from the main trunk, we call them sibling nodes. The concept can be a sub-concept of the previous one, in which case, we call it a child node. So the map will consist of a main parent node, typically the topic itself and a mesh of sibling and child nodes emerging out from the parent. To attach your next node, go to Insert -> New Child Node or New Sibling Node. You can also start a new map with Insert -> New Parent Node.

Figure 11.26: A concept map in FreeMind

There are a number of options for the shape of your nodes, the connectors between them, and the colours of the nodes. This not only helps beautifying your map, but also helps visual categorising of the concepts. The text inside the nodes can be plain text or hyperlinks. You can also include images.

Once you complete your map, the page can be exported out as a web page, a pdf or an image. You can then project it in your classroom and use the concept map as a teaching-learning aid. You can also assign the task of constructing a concept map to students, individually or in groups. Observing the process and asking relevant questions can also help evaluate their understanding.

Do tryout this tool and explore the various possibilities.

11.8 LET US SUM UP

Some of the important points discussed in this unit are summarized below:

- Graphics are being increasingly used to communicate. With the advent of computer software, graphics have evolved into a very powerful and sophisticated means of visual communication.
- A variety of graphic forms are used in instruction, including graphs, maps, diagrams, and charts.
- The specific purposes of communication, effective use of different elements of the particular graphic form, and the level of the viewer have a bearing on the impact of the graphic.
• Computer graphics software provides too many choices and options. While some of these options are very useful, others could serve a purely cosmetic purpose.

• Digital graphics come in two broad formats – vectors and rasters. Vector graphics are scalable and are suitable for mathematically definable images like line drawings, graphs, etc. Raster or bitmap graphics are suitable for a wider variety of images.

• Different file formats are used to save images in both vector and raster formats. They are inter-convertible. Differences in the way they process images, different formats have different advantages and limitations. File formats like .jpg, .gif, and .png are used for web graphics, .tif, .bmp and .tga are used in video and print applications.

• Combining progressively changing images and playing them in a sequence results in perception of motion. This technique is used in motion graphics, video and animation.

• Colour theory categorises the range of colours into primary, secondary and tertiary colours. While primary colours cannot be generated from each other, combining primary colours results in secondary colours. Different combinations of primary and secondary colours result in the complete range of tertiary colours.

• Red, green and blue are the primary colours of light, while cyan, magenta and yellow are the primary colours of pigments. Colours are further categorised on the basis of their tints, tones and shades or hues, saturation and tonal values.

• Computer graphic software use a colour wheel or similar devices to enable selection of colours. Colours are identified by a 16 digit code and computer software can distinctly identify 256 shades of each primary colour, resulting in 16 million combinations.

• We explored development of graphics using Openoffice.org Draw, Microsoft Paint and GIMP. We also studied the development of a slide show using Openoffice.org Impress and a photo album using Picasa. These software have a large number of features and can be used to develop a variety of graphics for a variety of purposes.

• Concept mapping is a convenient device to depict relationships between different concepts and sub-concepts. This device can be used quite effectively in teaching and in evaluating. We explored the use of Freemind to develop and display concept maps.

11.9 KEYWORDS

Animation: is a process of rapid display of 2D or 3D images to create an illusion of movement.

Concept mapping: is the act of preparing image that shows relationship amongst concepts depicted in it.

Graphics: are used to visually represent information. They can be line diagrams, photographs, and computer generated drawing.

Pixel: is used a short form of Picture Element. It is the smallest addressable screen element.

Raster graphics: is a collection of dots called pixel. When an image is scanned, the image is converted to a collection of pixels called a raster image.

Vector graphics: is a category of images made up of lines and curves that are created mathematically. These are resolution independent and can be stretched or resized.
11.10 REFERENCES AND FURTHER READINGS


11.11 FEEDBACK TO CHECK YOUR PROGRESS QUESTIONS

Check Your Progress 11.1

a) A discussion on the fuel crises

The very fact that we are discussing the issue, there must be many facets to the issue and many different view points. Much of a report on such a discussion will be textual. Important facts, data comparisons, evidence of effects may constitute the content. Different kinds of tables and graphs would be appropriate to the presentation. Will we have a choice of graphs or will particular types of graphs be more appropriate? Think it over.

b) A report on votes polled by different parties in an election

The report will basically consist of numbers pertaining to various seats, regions, parties and candidates. Again tables and graphs would be appropriate. As comparison of parties is to be made in various constituencies, pie charts would be one appropriate choice. A bar chart or X-Y graph can also be used.

c) A building plan

Obviously, the plan is a diagrammatic representation of a building, with drawings for elevation, floor plan, etc. A detailed drawing drawn to scale would be the choice

Check Your Progress 11.2

1) Primary colours are those colours which cannot be obtained on mixing other colours. For light (also known as additive) red, green and blue are the primary colours. For pigments (also known as subtractive) cyan, magenta and yellow are the primary colours. To understand the difference between the two types of colours, let us consider the example of a colour, say chrome yellow. In the case of light, every colour has a particular frequency associated with it. So, in order to generate light of chrome yellow, you add green and blue in the right proportion to generate a light of chrome yellow colour. When white light falls on an object of a particular colour, the object absorbs all other colours reflecting back only that particular colour. So, for an object to appear as chrome yellow, the pigments in the object should absorb all other colours and reflect back chrome yellow.

2) While sunlight, at noon is the nearest to white light, the presence of dust in the atmosphere, and/or the sun’s elevation (how close the sun is to the horizon) will redden the sun. This means the sunlight now contains more of red than of other colours. Therefore this will be akin to watching an object through a red or orange filter. If you look at a green leaf, there is less of green reflected from it, making it appear darker. The green is of a darker shade.
3) Pure blue has zero green and zero red. The different shades of blue will have a little green or a little red, a little black or a little white mixed with pure blue. Let us say you choose the colours 0000ff (pure blue) or 0001ff (blue with a little green) or 0100ff (blue with a little red) can you make out the difference? This of course can only be confirmed by you actually doing the exercise.

4) As we mentioned having names for all the 16 million colours is next to silly. Further as you will learn in the chapter on HTML, it would be very convenient and efficient to send a number from one computer to another and let the receiving computer generate its own colour. File sizes can become really small. Hexcodes are also very useful while matching colours in graphics. Let us say, you are touching up or correcting an image and you need to pick up the exact shade of red – knowing the hexcode will allow you to precisely identify the red. In GIMP for instance, open the original graphic; select the colour picker tool from the toolbox (the ink dropper). Press shift and the left mouse button simultaneously and move your mouse over the image. The click will open up a colour picker dialog and as you move your cursor around, it will show the colours you choose. Notice the details of this colour, including the hexcodes displayed in this dialog.
Content Creation Tools
UNIT 12 DIGITAL AUDIO

Structure
12.0 Introduction
12.1 Learning Outcomes
12.2 What is Sound?
12.3 Components of Audio
12.4 Sound Quality
12.5 Digital Audio Formats
12.6 Sound Recording: Basics
12.7 Sound Recording: Technology
12.8 Design and Development of Audio Programmes
   12.8.1 Planning and Organizing
   12.8.2 Recording Audio Using Audacity
   12.8.3 Editing and Mixing
12.9 Streaming Audio Technology and Applications
12.10 Let Us Sum Up
12.11 Keywords
12.12 References and Further Readings
12.13 Feedback to Check Your Progress Questions

12.0 INTRODUCTION

Sound is an integral part of human life, with exception of those with hearing impairment. Stories are part of our childhood; we have grown listening to songs and music of our culture. In ancient India, “word of mouth” was a major way of instruction at the Gurukul. If you ask a kid to cram a poem that is given in a book, he/she will have to exert a lot of efforts. But if you ask him/her to remember the lyrics of a popular film song, he/she will do it very quickly without exerting too much of efforts. The nature of sound/audio has strong effect on our mind. The use of sound/music can identify and relate to emotions such as sad/happy, upbeat/down, celebrating/mourning, partying or is in solace. Soundtracks in the background are used to create the adequate environment for the situation.

Audio is a vital media in distance education framework. It is because a human brain seldom thinks on one sense. Audio in distance education setup can be found in different file formats and in different qualities. There is tradeoff between the size of the audio file and quality of the sound. In this unit, we would like to understand various dimensions of digital audio and how to use them in distance education.

12.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:

- Identify different types of digital audio formats;
- Describe the advantages of digital audio; and
- Record and create digital audio in different conditions for use in educational contexts.
12.2 WHAT IS SOUND?

If we vary air pressure, a sensation is created. This sensation is detected by the ear and thus we are able to hear some kind of sound. We hear different kind of sounds due to different kind of mediums and different pressures. If you play a song in your car stereo, you can change its sound by choosing the pop mode or the rock mode or the soft mode. If the variation in air pressure is between 20 Hz and 20 kHz the sound is audible. You must have seen the bass and treble buttons in your music player. Bass equalizes the sound frequencies in the range of 1000 Hz and treble equalizes the sound frequencies around 10,000 Hz. Sound is produced when the air is disturbed in some way. Our ears are able to hear sounds as they have ear drums. A very small movement of ear drums is audible.

Sound is a traveling wave that is product of an oscillation of pressure transmitted through audible range of frequencies. Sound travels through gases, liquids, solids, and plasma. It can't travel in vacuum. In this unit we are interested in recording of sound in digital audio form for use in teaching and learning.

12.3 COMPONENTS OF AUDIO

Audio is divided in three major types. These are music, special effects (SFX) and voice-over (VO). In this section, you will learn about them in brief.

Music

The word music has origins in Greek. It is derived from the word “muses”. Muses mean goddesses who are sources of knowledge and inspire creation of art and literature. Just like for a painting the medium is paper, medium for music is sound. There are several properties of music. The first property is pitch of the sound. If a musical instrument is played then the air particles in the air will start vibrating with the same frequency. This will carry the sound signal to the ear of the listener. This signal is the pitch of the sound. The judges in musical competitions are capable of differentiating minutely between the pitch of separate sounds. If a contestant deviates from the instruments, there would be a discord in harmony and the song would not remain melodious. The second property is rhythm. Music is generally created on the basis of rhythm. In Indian music, we call this rhythmic pattern as “tala”. Another property of music is the source from which it is created. For example, sound from a flute will differ from a sitar, even if both are playing at same frequency. Similarly a guitar would sound differently than a sitar, even if both use strings for the creation of sound.

Use of appropriate music in an audio production can enhance the quality of production and its effectiveness. Music is either used solo (as in a music album or used as background music to provide the desired effect of the main cast in the video. It has the quality to motivate and soften the presentation of the content.

Sound Effects (SFX)

Have you ever thought about various strange sounds that you hear while you watch movies or television or listen to radio? An alien talking in very sharp childish voice, while another one talking in very heavy bass-based voice. Actually all this is the work of sound engineers who put special effects
Digital Audio

(SFX) in normal voice and make it special. There are virtually all possible permutations combinations available through advanced software. One can make a voice slow or fast, turn the sound backward, add an echo or distort a sound. Sound effects are used to create mood and environment such as night, forest, fear, river, etc.

Voice Over (VO)

Voice-over (VO) is off-screen commentary. You see an actor singing on the screen, but actually the song is sung by a singer. The song is actually recorded in a studio with all infrastructures. The TV news that you hear depicts important video clippings with voice-over by the news reader. Actually what you listen is a combination of many sounds apart from the news reader. In distance education, there are many applications of voice-over. The use of voice over is often done in documentary video programmes. It is addition of voice other than that of the main cast in the frame. We use voice over to further explain and elaborate a visual sequence/scene/scenario.

Besides the use of music, voice over and special effects, silence is also used in audio recordings. It includes sudden, abrupt silences conveying stillness, peace, death, doom etc. A combination or blending of several sound elements such as music, effects, etc. is sometimes used to enrich and emphasize picture meaning and impact.

Check Your Progress 12.1

Notes: a) Write your answers in the space given below.
   b) Compare your answers with those given at the end of this unit.

1) What is sound?
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................

2) In what condition sound is audible?
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................

3) What are the components of audio?
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................
   ............................................................................................................

   ignou

   THE PEOPLE’S UNIVERSITY

   41
12.4 SOUND QUALITY

The quality of sound depends on the nature of the recording device, ambience of the recording and the type of technology used. For example, a programme recorded in a sound proof studio will have different quality than the one recorded live in an open location. Appropriate use of the microphone also has impact on the quality of sound recorded. The quality of sound in the record also depends on the recording technology used – analog or digital. Sound waves consists of continuous variations in air pressure that can be recorded using both of the techniques.

Analog

Analog recording is giving way to digital recording these days. The continuous pressure variations in the sound waves are converted into electrical signal and recorded in a magnetic tape or the deviation of the groove of a gramophone disc. The journey of music started with analog devices like Phonograph which was the first device that could record sound mechanically (1857). This was followed by invention of Gramophone Disc (1889) and magnetic tape & the tape recorder (1940).

Digital

In the digital recording, the original sound wave is first converted into analog signal which in turn is converted into a sequence of 0 and 1 using an electronic device. While there is debate over the quality of audio in digital is superior over analog mode of recording, the sue of digital recording is predominant in the industry, as it gives scope for manipulation of the recorded sound by cutting, mixing and adding. Digital recordings are available in Compact Disc and other physical formats.

12.5 DIGITAL AUDIO FORMATS

An audio file format is a format that can contain various types of audio data, compressed by means of standardized audio/video codecs for storing on a computer system. A codec is a program capable of encoding and/or decoding a digital data stream. The word codec is derived from first two alphabets of “coder” and first three alphabets of “decoder”. A codec is different from a file as codec performs the encoding and decoding of the raw audio data while the data itself is stored in a file with a specific audio file format. Some of popular audio file formats are as follows:

- **Musical Instrument Digital Interface (MIDI)**: This type of format has the extension “.mid”. MIDI is a standard adopted by the electronic music industry for controlling devices, such as synthesizers and sound cards that produce music. At minimum, a MIDI representation of a sound includes values for the note’s pitch, length, and volume.

- **Compact Disc format**: You must have seen that audio CD’s have an extension “.cdda”. This format is called the Red Book format. It is the standard for audio CDs (Compact Disc Digital Audio system, or CDDA). The first edition of this format was released in 1980 by Phillips and Sony.

- **Uncompressed audio formats**: These are free and open file formats. The most popular format in this category is WAV format. WAV is a file format designed to store and archives an original recording. It can save any combination of sampling rates or bit rates. Broadcast Wave Format (BWF) is the preferred file format in the Television and Film industry. AIFF is the standard audio file format used by Apple. It is like a wav file
for the Mac. AU is the standard audio file format used by Sun, Unix and Java.

- **Formats with lossless compression:** A lossless compressed format is more efficient than uncompressed format in terms of space used but requires more processing for the time recorded. An example of this format is the Windows Media Audio (WMA). It is an audio data compression technology developed by Microsoft. It is a proprietary technology which forms part of the Windows Media framework. Today it is one of the most popular codecs, together with MP3, RealAudio and MPEG-4 AAC.

- **Formats with lossy compression:** A lossy compressed format is the most efficient format in terms of space used. It compromises with the quality of the sound but still is very popular. It is used in many applications such as streaming media and internet telephony. MP3 or MPEG-1 Audio Layer 3 is a digital audio format that is the most popular format for digital audio players. Advanced Audio Coding (AAC) is another lossy compression format for digital audio. It is poised to be the successor of the MP3 format. It is mainly used by Sony and Apple for their mobiles and playstations. The format has file extensions as .aac, .3gp, .mp4 and .m4a. RealAudio is another popular proprietary audio format developed by Real Networks. One of main uses of this format is in streaming audio. It can be played simultaneously while been downloaded. Many internet radio stations use RealAudio to stream their programming over the internet in real time. The first version of RealAudio was released in 1995. The format has file extensions as .ra, .rm and .ram.

**Comparison of File Size and Quality**

MIDI format takes very little space and is used in mobile phone for ring tones. It is popular in educational setup too. Because of its size this format is quite often used in PowerPoint slides and on web pages. The CD format takes a lot of space but sound quality is very good. A 700 MB CD for example can save up to 10-12 songs. WAV files require around 10 MB of space per minute of sound recorded. This makes their size huge e.g. a song of 5 minutes could take around 50 MB. An MP3 file that is created with adequate bit rate setting takes about 1/10th the size of the CD file created from the original audio source.

**Open and Proprietary Audio Formats**

The range of audio format available is quite confusing to an ordinary user, especially when you want to use it for educational purpose and would like to distribute audio in a format without paying heavy license fee to use the format. Some formats are proprietary, and would require you to pay fees, while others are open formats. In Table 12.1 we give you a list of open and proprietary formats.

<table>
<thead>
<tr>
<th>Open Formats</th>
<th>Proprietary Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>.WAV</td>
<td>.WMA</td>
</tr>
<tr>
<td>.OGG</td>
<td>.RA</td>
</tr>
<tr>
<td>.AU</td>
<td>.MP3</td>
</tr>
<tr>
<td>.AIFF</td>
<td>.3GP</td>
</tr>
<tr>
<td>.MP4</td>
<td></td>
</tr>
<tr>
<td>.AAC</td>
<td></td>
</tr>
</tbody>
</table>
12.6 SOUND RECORDING: BASICS

The quality of sound that one hears depends on several parameters. These parameters are sampling frequency, bit rates and psychoacoustics.

Sampling Rate

The sampling frequency or sample rate is defined as the number of samples (signals) per second (or per other unit) taken from a continuous signal to make a discrete signal. It is measured in hertz (Hz). This has a direct bearing on the quality of sound. Some of examples of the sound quality and sampling frequency tradeoff are telephone quality (8,000 Hz), MW (AM) quality (32 kbit/s), FM quality (96 kbit/s), Standard bit rate quality (128–160 kbit/s), New ‘standard’ bit rate for MP3 music (192 kbit/s) and CD quality (44,100 Hz), Digital TV, DVD and films (48,000 Hz); DVD-Audio, BD-ROM (Blu-Ray Disc) audio tracks, and HD DVD (High-Definition DVD) audio tracks (96,000 Hz).

Bit Depth

Bit rate is the number of bits that are conveyed or processed per unit of time. A bit (binary digit) is a basic unit of information storage and communication. The bit rate is quantified using the bits per second (bps) or kilobits per second (kbps). Bit rate can be taken as an indicator of the sound quality. For example an MP3 file can also be constructed at higher or lower bit rates, with higher or lower resulting quality. Some of examples of the sound quality and bit rate tradeoff are telephone quality (8 kbit/s), MW (AM) quality (32 kbit/s), FM quality (96 kbit/s), standard bit rate quality (128–160 kbit/s), new ‘standard’ bit rate for MP3 music (192 kbit/s) and CD quality (224–320 kbit/s).

12.7 SOUND RECORDING: TECHNOLOGY

While recording to sound requires specific hardware and software, we will only highlight the microphone in this section. You need a multi-media enabled computer with audio and video capture card, a good quality microphone, a speaker or headphone, and appropriate software to record audio. Of course, the environment is very important.

Kinds of Microphones

For the sound recordist, there are a wide variety of microphones available today. What kind of microphone one should choose, depends primarily on the production requirements in a particular situation. Basically, there are three types of microphone:

i) **Dynamic microphones:** These microphones are sufficiently rugged for most recording situations and can be positioned close to the source of sound. They can tolerate very high sounds safely.

ii) **Condenser microphones:** These mics are highly sensitive to physical shock but give excellent quality sounds from a distant source. A condenser mic requires a power supply in the form of a renewable battery.

iii) **Ribbon microphones:** These mics are also very sensitive to physical shock, but produce very high quality sound. A ribbon mic is suitable for recording controlled and static sounds of speech and music, and is quite rugged and compact.
Microphones are also classified according to their directional sensitivity to the incoming sound. They are of three types:

i) *Cardioid mics:* A cardioid microphone is sensitive to sounds coming from half the environments to which it is pointing. Being unidirectional, these mics are useful in recording interviews because they reduce unwanted sounds from the background. Because they are ‘heart-shaped’ they are called cardioid microphones.

ii) *Omnidirectional mics:* This kind of microphone is sensitive to sound coming from any direction. There are also bidirectional microphones, designed in a pattern of the figure of eight.

iii) *Gun mics:* Also called rifle mics, these are sensitive only to a narrow angle of sound and ignore other environmental sounds in the studio or location. Fitted with a long pointed handle or boom, gun microphones can record sound from quite a distance and are generally used along with headphones to monitor the output and ensure the right position of the microphones.

These days, recording of sound and lecture has become very easy, as mobile phones, and portable digital recorders that can directly record audio into MP3 formats are available. You can use any of these to record sound directly or use a computer-based system to record audio and duplicate into CDs or deliver these online.

**Check Your Progress 12.2**

*Notes:* a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Write True or False.

a) The first mechanical audio recording device was invented in 1857.

b) MIDI format is used mostly in synthesizers and sound cards of computers.

c) The Red Book format for audio is WAV.

d) The audio data compression technology developed by Microsoft is WMA.

e) Loosy compression format takes less space to store audio.

f) Higher bit rate produces low quality audio.

### 12.8 DESIGN AND DEVELOPMENT OF AUDIO PROGRAMMES

In this section, issues related to the designing and developing an audio program will be dealt with. The software Audacity will be used for demonstrating the related concepts. Audacity is free, open source software for recording and editing sounds. Audacity can be freely downloaded from the site http://audacity.sourceforge.net/. Audacity can record live audio through a microphone or mixer, or digitize recordings. It can import sound files, edit them, and combine them with other files or new recordings. It can then export your recordings in several common file formats like mp3, wav. It can edit and mix a number of tracks with cut, copy, paste, and delete functions. It can also add effects to the sounds like the “Bass Boost effect” and the “Normalize effect”.
12.8.1 Planning and Organizing

Before recording any audio programme, it is important to plan it and organize relevant activities so that you do not face problem at the time of recording. There are four steps planning and organizing:

1) Clarify audience and objective
2) Decide format and length
3) Setup hardware and software
4) Prepare the script and/or the interviewee

Step 1

The important step in planning is to clarify the objective of the audio and its target audience. For whom are you planning the audio? Who will benefit out of it? What you expect the learner to do after listening to the programme. At this stage also think about how the learners are going to access and use the audio recording. Will it be available on CDs at the study centre? Are you going to make it available on your website or e-learning portal? What would be the mode of delivery on the web — download or streaming?

Step 2

Thinking about the audience, objectives and delivery method would help you to decide on the format of the programme and its appropriate length. If you want the audio recording to be delivered as a podcast, it is better that the same is available in time length of 10-15 minutes. If you intend that the audio will be delivered on CD, and the learners will use the same at home or study centre, you can go for about 20-30 minutes programme. However, the format of the audio programme will vary from subject to subject. We have discussed about the format of audio programmes in Unit 6. Some of these are lecture, interview, group discussion, etc.

Step 3

The nest step in the planning process is setting up the hardware and software, and making the studio ready for recording. If recording is to be done on location, we still need to have appropriate recording devices. The following may be checked as preparation for recording:

- Recording software (Audacity in this case) is available on the computer; you can download Audacity form http://audacity.sourceforge.net/. Also do not forget to download LAME MP3 Encoder that will be required to convert your audio file into MP3 format;
- A suitable mic is attached to the computer, and it is working;
- A speaker/headphone is attached and it is working;
- Alternative power backup is available online; and
- Recording room is noise free

Step 4

The next planning step is to finalize what you want to record. If it is a lecture, you should have the written script available in print in one side of the page. Do not staple the sheets. If you want to interview an expert, it is better to have the questions on hand, and familiarize yourself with the subject concerned. Before, the actual recording, it is useful to rehearse and check recording to check the level of voice.
12.8.2 Recording Audio Using Audacity

Before you start Audacity on your computer, check that recording is on in your audio (do a check through control panel, if you are using Windows), and also check that none of the options such as Mic Volume, Stereo Mix, Phone Line, etc, are not in mute condition. To record your programme just do the following:

1) Start Audacity, and you will see the screen as in Figure 12.1. The interface has audio player-like options, such as Record, Play, Pause, Stop, Skip to end and Skip to start.

2) Go to Edit in the Main Menu, and click Preferences. You will find a tab with many options such as Audio I/O, Quality, File Format, etc. Essentially these three are important for you. Check the in Playback and Recording device; decide the sample rate for recording; the file format, especially check whether LAME is available or not.

3) Once you are ready, click the “Record” button on the screen, the recording starts, and you have to speak to the microphone. Just go on as planned for the programme. (see Figure 12.2)

4) As you complete the recording, just click the “Stop” button.

5) Save the file at an appropriate folder. Remember this file will have an extension “.aup”.

Figure 12.1: Audacity Interface

Figure 12.2: Recording in Audacity
12.8.3 Editing and Mixing

Editing in Audacity is like using the wordprocessor. You can actually select a portion of the wave on the screen, and delete, copy, paste. This is a very useful function, as during the recording, if you have paused for longer time or you have had an unwanted cough, you can actually select that portion and delete. You can also add silence at places if want. You can also mix other background music into the programme by importing another file. This is called mixing. Go to “Project” in the Main Menu, and import audio for a pre-saved folder. Once you add another file on to the system, you will have another band of wave on the screen (see Figure 12.3). Once you finish the editing by using various effects feature of Audacity, you can save the file, as “Save Project As”. This is because your original file has only one recording, and it should be left as it is for future further editing, if required.

To make a .wav file or .mp3 file, you will have to export the “.aup” file as wav or mp3 as the case may be. Audacity can export it as a wav file by itself but if you want to export it as an mp3 file, you will have to use “LAME Encoder”. Lastly, you define ID3 tag pertaining to your mp3. ID3 tag is basically metadata pertaining to a music file (see Figure 12.4). Now, your audio file is ready for distribution through CD or Website.
12.9 STREAMING AUDIO TECHNOLOGY AND APPLICATIONS

What happens when you download a song on your computer? It is stored on the hard disk and that consumes hard disk space. Now if you happen to listen the song while downloading it, it will be wonderful. Streaming audio does the same thing. It buffers the song for a short period and enables you to listen that. While you hear the already buffered part, it buffers another part (normally of 0.5 min duration).

Streaming was pioneered by RealNetworks to deliver audio via the Internet. The audio file remains on a server. When the file is requested by a client computer, the initial part is copied to a buffer on the user computer, and after a short delay starts to play, while the rest of the file continues to be pulled from the server and being copied to the buffer. The buffering process makes the play of audio continuous, if the bandwidth is at least 512 kbps. Streaming technology is used by all Internet radio stations. In fact with the use of streaming technology, live events can also be broadcast over the Internet. It is used in many ways in education setup such as for presenting audio lectures online and for providing supplementary materials through audio channel. The future belongs to the streaming media as it has helped in removing the distance barrier and that too in real-time.

12.10 LET US SUM UP

Audio is a vital media in content creation framework as it addresses to yet another human sense in context of contents. In this unit you have discussed components of audio like music, SFX, VO and silence. You have deliberated on the issues of sound quality like analog and digital formats. Importance of sampling frequency and bit depth was explained in the context of sound recording. Tradeoff between the size of the audio file and quality of the sound was also demonstrated. Finally, you have used Audacity to generate your audio embedded lecture. Audacity works for the audio in the same manner as Microsoft Word works for the text. With this essential background and your unbounded creativity, it is expected that you will develop very good contents based on audio.

12.11 KEYWORDS

**Bass**: refers to the heaviness in the sound. It equalizes the sound frequencies in the range of 1000 Hz

**Bit rate**: is the number of bits that are conveyed or processed per unit of time. A bit (binary digit) is a basic unit of information storage and communication.

**Codec**: is a program capable of encoding and/or decoding a digital data stream.

**Hertz, kiloHertz (Hz)**: named for an early researcher in audio, Hertz means “cycles per second”, and is the way we express audio frequency. One Hz is one complete cycle of a sound wave per second. We perceive higher frequencies as higher pitched sounds, lower frequencies as lower pitches. Frequencies are also described in kilohertz (thousand cycles per second), as in “22 Khz”.

**MIDI**: is a standard adopted by the electronic music industry for controlling devices, such as synthesizers and sound cards that produce music.

**Pitch of the sound**: If a musical instrument is played then the air particles in the air will start vibrating with the same frequency. This will carry the sound signal to the ear of the listener. This signal is the pitch of the sound.
**Sampling rate** - the number of samples per second that are taken of an audio signal to produce a digitized audio file, expressed in kiloHertz (kHz). Common rates are 11.025 kHz, 22.050 kHz, and 44.100 kHz. The higher the sampling rate, the better the sound quality.

**Special effects**: refers to changes in original sound like making a voice slow or fast, turn the sound backward, add an echo or distort a sound.

**Treble**: refers to the sharpness in the sound. It equalizes the sound frequencies around 10,000 Hz.

### 12.12 REFERENCES AND FURTHER READINGS


### 12.13 FEEDBACK TO CHECK YOUR PROGRESS QUESTIONS

**Check Your Progress 12.1**

1) It is a traveling wave that is a product of oscillation of pressure transmitted through audible range of frequencies.

2) If variation in air pressure is between 20Hz and 20 KHz, then sound is audible.

3) The components of audio are: voice over, special effects, music and silence.

**Check Your Progress 12.2**

a) True. Invented by Frenchman Édouard-Léon Scott de Martinville in 1857, the *phonograph* is the earliest known device for directly transcribing sound.

b) True. MIDI format is almost an industry standard for soundcards.

c) False. The Red Book format for audio is CDDA.

d) True. As the name suggests Windows Media Audio (WMA) is the format developed by Microsoft.

e) True. MP3 is a lossy compression format, and it takes least space for storing audio file.

f) False. The higher the bit rate, the quality of audio is better.
UNIT 13 DIGITAL VIDEO

Structure

13.0 Introduction
13.1 Learning Outcomes
13.2 Video Basics
   13.2.1 Analog Vs. Digital
   13.2.2 Frame Rate and Resolution
   13.2.3 Interlaced and Non-interlaced video
   13.2.4 Video Colour System
   13.2.5 Capturing Digital Video
   13.2.6 Video Compression and Streaming Video
13.3 Digital Video Technology
   13.3.1 IEEE 1394
   13.3.2 MPEG
13.4 Computer Configuration for Digital Video
   13.4.1 Computer
   13.4.2 Storage Device
   13.4.3 Video Capture Card
   13.4.4 Camcorder
   13.4.5 Cables and Connectors
13.5 Process of Video Production
   13.5.1 Pre-production
   13.5.2 Production
   13.5.3 Post Production
13.6 Video Editing Using Movie Maker
13.7 Using Web-based Video Editing Tool
13.8 Let Us Sum Up
13.9 Keywords
13.10 References and Further Readings.
13.11 Feedback to Check Your Progress Questions

13.0 INTRODUCTION

With the universal invasion of television in to our homes, there is perhaps a very rare chance that you are not aware of video as a medium of communication. And with hundreds of different channels focusing on different target audiences, you are also aware of the wide range of possibilities the video medium offers.

From a news reader reading out a report kind of presentation to a high drama crocodile hunter in action, to Swamis demonstrating yoga to a soap opera, to a movie to a game show, you have perhaps by now seen almost all possible ways in which this medium can be leveraged for effective communication.

As opposed to cinema, television is known to be a close up and a far more invasive medium - it can reach out to you even when you are relaxing in your bedroom. And at a technological level, video has become a common man’s medium. Today even a novice can wield a small hand held video camera, even a mobile phone with a video recording facility and make short
movies. It took some time for people to recognize the power and utility of
this medium and its miniaturized, simplified technologies, but it has begun
to be universally used.

For our purpose, video is no more restricted to buying a DVD (earlier you
would buy a videotape) and showing it in the classroom. Every teacher,
every student can now be the author of a video. Think how this opens out a
large canvas of possibilities for its use in education, and how it supports
modern educational thought and practice.

We will attempt to understand this medium from a technological point of
view, so that you could leverage this to make your own educational
communication more effective.

Now that video has gone digital, we also dream of placing video files on the
web and play or download it world wide. The size of the video file will of
course have enormous implications. Ways of managing this size and its
effects on the attributes of the video itself will also be explored.

13.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:
• Identify different types of digital video formats;
• Describe the advantages of digital video;
• Record and create digital video for use in different conditions; and
• Design a video for an educational communication

13.2 VIDEO BASICS

While visually video resembles cinema very much, technologically it is
drastically different. In fact this is what has enabled video to be miniaturized
and converted into an amateur device. Cinema is based on a series of still
pictures, played at a speed where the eye sees it as a constant picture, or a
continuous moving scene. Hence if an action is depicted as a progressive set
of pictures, and played at this speed, the viewer would see the action, as if it
is happening in real time. That is why this technology of moving images is
referred to as a movie. Video retains this concept of playing out frames
sequentially and rapidly, but unlike cinema, stores the information on a
magnetic media (and nowadays, on optical media too). While recording, the
optical information is stored as electromagnetic information on the magnetic
tape and played back using a reading head like in an audio tape recorder.
This has resulted in a large range of devices of different formats and sizes of
tapes and tape recorders. You would have heard of VHS, S-Video, DAT etc.
Among the optical playback media, you would have heard of VCD and DVD
which use a laser beam to read. Many other formats have been used in
professional recording.

Playing back of video also differs from cinema at the technological level.
While you would use an optical projector, shining light through a film, in the
case of cinema, you use a television monitor to play back video. The
television monitor uses a cathode ray tube to reconstruct the image from the
electromagnetic signal received from the tape or the camera.

The way the television plays back information has implications for picture
quality. Let us examine this in some detail. The cathode ray tube, as may be
aware produces a continuous ray of electrons. These electrons, when they
strike a phosphorescent screen produce a spot of light, a dot on the screen.

In a television monitor, this ray of electrons is made to scan across the screen
to generate a line, rather a closely packed row of dots (You have learnt this in
Unit 11). At the end of each line, the signal retraces to the left edge of the
display, goes a step down and then starts scanning the next line, and then the
next. Starting at the top, all of the lines on the display are scanned in this
way. One complete set of lines makes a picture. This is called a frame. Once
the first complete picture is scanned, the scanning circuit retraces to the top
of the display and starts scanning the next frame, or picture. This sequence is
repeated at a fast enough rate so that the displayed images are perceived to
have continuity and if the image depicts motion, you would see a continuous
one.

In the case of a black and white television monitor, the screen produces a
white spot, whose brightness is varied through a range of gray shades from
black to white, thereby producing the picture. In the case of a colour
television, each dot on the screen is actually composed of three dots of
phosphor, capable of responding to the electron beam and produce red,
green and blue dots respectively, which together can generate an image of
any colour.

**Check Your Progress 13.1**

*Notes:*  
  a) Write your answer in the space given below.
  
  b) Compare your answer with the one given at the end of this unit.

Describe the scanning process in a cathode ray tube based monitor. What
limitations does it place on the display of images?

13.2.1 Analog Vs. Digital

Electricity and Electromagnetic waves, which include light, radio waves or
even x-rays are transmitted as a continuous wave, which depends on the
frequency and the amplitude of the varying quantity, say voltage, or colour
and intensity of the light. Any signal which can be superposed on these
waves can use them as a carrier and be transmitted across large distances or
stored on magnetic or optical media. This is exactly what happens to the
audio and video signals generated by the video camera. And as the variation
of the audio or video signal (being electrical in origin) is analogous to the
carrying electrical signal, we refer to it as analog.
A typical cathode ray tube based television monitor, strips the carrier and uses the audio and video signal to generate the image and sound.

A digital signal is composed of a square wave, the flat peak representing *one* or *on* or *true* and the base line representing *zero* or *off* or *false* (See Figure 13.1). All computers and therefore computer displays receive and process digital signals. If you happen to have a cathode ray tube based monitor, then the graphics card on your computer is actually converting the digital signal to an analog signal, which is then processed to display images. The LCD, Plasma or LED displays directly use the digital signal to display images. Some of these may even have a capability to receive and process an analog signal, in which case it converts it into a digital signal. Such conversion from analog to digital or vice versa is referred to as modulation and demodulation.

### 13.2.2 Frame Rate and Resolution

A cinema or motion picture reel moves 24 frames every second, a television monitor 25 frames every second. This means, between every single frame there must be an interval of time, however tiny, when the screen is actually blank. The human eye's inability to see these blank in-betweens is what has made cinema, animation or television possible. Referred to as persistence of vision, this failure enables our perception of one continuous smooth motion. The minimum frame rate to achieve the illusion of a moving image [persistence of vision] is about fifteen frames per second.

Worldwide, three major video standards have been adopted. While PAL (used in Europe, Asia, Australia, etc.) and SECAM (used in France, Russia, parts of Africa etc.) standards specify 25 frames per second; NTSC (USA, Canada, Japan, etc.) specifies 29.97 frames per second. This is referred to as the frame rate. How fast is this? To give you an idea, consider the fact that you would see 25 frames every second using a PAL device, for you to perceive a continuous image. So every frame is constructed in one-twenty fifth of a second. A typical television screen consists of 576 horizontal lines. And each line is made up of 625 dots, creating a matrix of 360,000 dots. So each point of light constructed on the screen stays for 1/9,000,000 of a second.
We considered how a still image is constructed in Unit 11. You may like to revise it at this stage. Television and in fact computer screens too construct video images in exactly the same fashion, except that it changes to 25 times every second.

Modern day displays have evolved from the cathode ray tube to liquid crystal displays, plasma displays and light emitting diode displays. While each of them combines the red, green and blue dots to produce a dot of the desired colour, using different techniques, the basic scanning process we described above is still the same. What has changed of course is the size of the dot and the number of dots packed across the screen. This makes the screen display brighter and display more vivid colours, closer to the true colours.

The characteristics of the display, and in the case of a computer controlled system, the graphics capability, which governs the input to the display, have a bearing on the resolution of the image. While in the case of an analog display, the numbers of scan lines were fixed, so a larger screen only spaced out the dots. Obviously, you could not sit too close to a large screen television. With the advent of digital displays however, the number of pixels that could be packed on to the screen emerged as the factor. So, we have a range of display resolutions, 640 x 480, 800 x 600, 1024 x 768, and now 1280 x 1024 on regular desktop computer displays. As video is played in a window, the size of the video frame could be any fraction of this, all the way to a full screen one. So, if the original source has a smaller frame size, say 320 x 240 and you play it on a screen set to 1024 x 768, the video will play in a small window. If you now maximise the window or shift to a full screen video mode, you will still see the video but of a much poorer quality. The information available in the original video is smeared over a larger area leading to a loss in quality.

Notice that 640/480 or 800/600 or 1024/768 is in the ratio 4:3. This ratio, known as the aspect ratio, is in fact the standard for video. With the emergence of High Definition television (HD TV), a ratio of 16:9 is also becoming popular.

Check Your Progress 13.2

Notes:  a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

What is screen resolution? What do the numbers 640 x 480 or 1024x768 associated with it signify? What characteristics of an image will change when displayed on monitors of different resolutions?

................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
................................................................................................................................................
13.2.3 Interlaced and Non-interlaced Video

There are two different techniques used to “paint” the picture on the screen. Television signals are interlaced, and computer signals are progressive or non-interlaced. In the case of interlaced scanning, each picture (frame) is divided into two separate sub-pictures, referred to as fields. Two fields make up a frame. An interlaced picture is painted on the screen in two passes, by first scanning the horizontal lines of the first field and then retracing to the top of the screen and then scanning the horizontal lines for the second field in-between the first set. A progressive, or non-interlaced, picture is painted on the screen by scanning all of the horizontal lines of the picture in one pass from the top to the bottom. The technique of interlacing was to overcome the limitation of the speed of the scanning process, which led to a flicker in the image. With the advent of digital technologies, speed of all processes have increased tremendously and a progressive scan is becoming the standard, particularly with LCD, Plasma or LED screens.

13.2.4 Video Colour System

Just like the still image, the video is also constructed using the primary colours — Red, Green and Blue. Most home televisions and computer monitors accept a signal which is a composite of these three colours and information for synchronization of the signal. Professional video devices use other combinations, or even separate signals for each colour. See Unit 11 for a description of how these three primary colours combine to generate other colours.

13.2.5 Capturing Digital Video

Capturing digital video can be conceived of in two different contexts: one, where the source is analog; and two, where the source is digital. If you are using a video cassette player and a VHS tape as your storage or an analog video camera, you would require converting your video to a digital format. The basic device used for this purpose is a video capture card attached to a computer. The device and its supporting software perform the following functions:

- Convert the analog signal to a digital signal;
- Synchronise with the video playback device and copy video;
- Process the signal, reading and converting the video in to an appropriate format;
- Convert the image size, compress the image, or otherwise modify it to desired requirements;
- Facilitate the storing and retrieval of the digital video.

There are a variety of video capture cards and software and their choice depends on various factors like the source of video, the desired purpose and quality of the output digital file, and formats in which the video will be stored and processed. Different cards also permit different range of compressions of video (see section on video compression).

If the source of video is a digital device, say a digital handycam or a digital still camera with a video option, then standard ports like firewire or USB could be used depending on the output format of the camera. Generally, such devices have a built in storage medium like a memory card or disk. In such cases, the process is simply that of reading and copying the digital video files on to the hard disk of your computer.
13.2.6 Video Compression and Streaming Video

At this stage you might once again like to revise the section on file formats and file sizes in Unit 11. Just like it was necessary to resize and compress a single image, it is necessary (in fact even more so) to resize and compress video.

In the analog television world, the issue did not arise, as there was one standard being used across – same image size, same number of lines, same colour processing technology. Of course there were differences between PAL, SECAM and NTSC, they were mutually incompatible anyway and you did not resort to conversion. During that phase, television and video remained a job for the professionals.

Based on the purpose for your video – you might want it stored as a VCD, or as a DVD, or as a digital file on the hard disk to incorporate it into a slide show or a multimedia project. You may also want to upload your video on to the web and make it available to all. Each of these requirements will have different implications for the image size, file size and format of your video.

Playing back a video from a video player or a computer involves the reading of the file (decoding the format), and sending portions of the file in the right sequence from the storage area to the monitor. One would also expect a smooth playback of the video with the audio properly synchronized. In fact, the eyes and ears together can easily discern even the slightest mismatch between the audio and the video.

A simple rule of the thumb – smaller the file size, smoother will be its transfer. In the case of a computer, it would also involve the speeds and capacity of the CD/DVD drive, the memory (RAM), and the graphics card. To the extent, the file size is within the capacity of the computer, you can be sure of a smooth video playback. If the file is being played from the internet, the bandwidth of the internet connection and the speed of the server serving the video file also matters.

So, how do we ensure a smooth playback? What characteristics of the video file will affect its smooth transfer?

Image size of your video is identical to that you used for a still image. It refers to the width and height of the video window. As we noted earlier, the video window can be resized. So, unlike a television screen, where the image is always full screen, your video could occupy a portion of your screen, the remaining being used for other text and graphics. Simply put, larger the image size, larger the file size. You can resize the video using any video editing software.

The format of the video file also affects the size. There are a large number of video formats and a large number of media players too. Some examples are avi (audio video interleave files), qt (quick time files), mpg, mpg2, mpv2 (MPEG video files), mjpg (motion jpg file), mov (apple quick time), flv, swf (flash video files). As these file formats are specific to the video capture card you use, and you may not have much choice, while handling video from an analog source. Also, cameras and video editing software are built around specific file formats. So, even with digital files you may not have too much of a choice. Again, if you wish to serve your files through the web, the operating system and support software on the web server will restrict your choice. So for practical reasons, you may have to work with a few video
formats. But, you can still convert digital video files from one format to another using video convertor software.

Like in the case of still images, compression techniques are adopted to reduce file size. We will not get into the details of video compression, except to note that reduction of image size and change of format are both used appropriately to compress the file.

Typically a computer file can be operated upon only when it is complete. So when you try to playback a video, it will not play until the entire file is downloaded into the memory of the play back machine. This will seriously limit the performance of the video if the file sizes are large. In order to optimise the playback capability, the technique of streaming is adopted. Streaming basically involves enabling a player software to play the file as soon as a pre-defined part of it is downloaded. The video begins playing, while the file is progressively being downloaded. At the server end, it involves making copies of the video file available and enabling progressive downloads to each requesting client.

---

**Check Your Progress 13.3**

**Notes:**

a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

What factors come in the way of video being broadcast on the Internet?

---

**13.3 DIGITAL VIDEO TECHNOLOGY**

The digital signal basically consists of high voltage pulses and the blank between two consecutive pulses representing the base voltage or zero. This technology, therefore, has some distinct advantages over analog signals. Firstly, it can be transmitted over larger distances without losses. Even when losses do occur, it is easier to reconstruct them as they are a steady stream of pulses. They occupy much less space on storage and transmission devices leading to higher density transfer and hence better quality images. Random access to different parts of the digital file is possible thereby facilitating non-linear processing. This has led to enormous time and cost saving in the production process. The development of optical media (CD, DVD and now Blu-ray) has also eliminated the problems of wear out and fungal attacks which were common on magnetic tapes. Having thereby reduced the dependence on professional devices, it has now become possible for even normal desktop computers and laptops to play back or even construct videos.
13.3.1 IEEE 1394

IEEE 1394 is a standard developed by the Institute of Electrical and Electronics Engineers for high speed isochronous (a guaranteed and steady rate) data transfer. Most professional video devices support this interface which supports data transfer rates of up to 400Mbps (in 1394a) and 800Mbps (in 1394b). The high speed of this connection makes it ideal for devices that need to transfer high levels of data in real-time, such as video devices. And like USB, 1394 supports both Plug-and-Play and hot plugging, also providing power to peripheral devices. Apple Inc., which originally developed the technology, calls it the FireWire port. It is also known as i.link or Lynx.

So, when you need to transfer video from, say your camera to the computer, and have a choice of a fire wire port, you should opt for it. Also, if you have a choice while selecting a camera or a video capture card, you could look for this port.

13.3.2 MPEG

This is a standard for audio and video files, developed by the Motion Pictures Expert Group (therefore called MPEG). Extended from the JPG format, it is also a lossy compression format, meaning, you lose information when you compress.

This format has become extremely popular, particularly in audio (mp3) and video (mpg). While the first version MPEG1, compressed to 1.5 Mbit/s is still used to produce digital video of VHS quality (all VCD, for instance) broadcast video and audio use MPEG2 format which compresses video to between 3 and 15 Mbit/s (used for DVD, cable television, etc.).

MPEG2 devices are backward compatible that is they can decode MPEG1 also. While we are very likely to be using digital audio and video, we need to be aware of these standards and the file formats derived from these in order to choose appropriate codecs while digitizing, editing and exporting audio and video on to different devices or platforms, for instance the internet, or a VCD or a DVD.

13.4 COMPUTER CONFIGURATION FOR DIGITAL VIDEO

Most modern day desktop computers and even laptops have adequate capabilities to process digital video. By processing, we mean importing video from a camera, downloading a file and playing it back. What should those essential characteristics of the computer be? We would like a computer to be able to allow us to edit video too – crop it, trim it, add some special effects, titles, sound, transitions, resize it, compress it and store it in a desired media or even upload it on to a website. What should the computer be equipped with to handle such tasks.

13.4.1 Computer

Most graphics and video tasks are handled by the graphics card. Supported by a large enough memory, it is this card which enables smooth display of video. Modern day graphics cards have their own processors, their own memory and handle the entire graphics tasks literally on their own. The larger the graphics memory, larger will be the file size it will handle, which
translates to higher resolution, larger image size, and better colours. Most media management and editing are carried out by software.

13.4.2 Storage Device

Large enough hard disks will give you the freedom to acquire and store audio and video in large quantities. A typical raw (uncompressed) full screen video of say an hours duration could occupy up to about a 100 GB, simply beyond the capability of any computer to process. But, fortunately, nobody works with the whole video at a time. We always work with individual shots, which are typically a few seconds to a few minutes long. The storage space is also for the sound effects, music, commentary, stock shots, and various versions of our unfinished product. Hard disks have crossed the tera byte (1 000 000 000 000 bytes) range and hence no more an issue.

13.4.3 Video Capture Card

Video capture card, as we discussed earlier would be a very critical component if we have an analog source of video. The file formats, the compression, the editing software offered and therefore the quality of the final output will very much depend on this card. Connected as a daughter board on the computer, this card will possess all the audio and video inputs and outputs. Different kinds of connectors depending on the source, software to control the video recorder, selection of options and interface with the editing software could all be part of the video capture card. If you are dealing with high quality video from a professional camera, the video capture card will be the most critical and also the most expensive part of the system.

There are a range of cards available with software support for different operating systems. If you are setting up a video editing unit, the capture card will be the first item to be selected. The specifications of the computer and the range of accessories needed will be decided on the basis of this card. In turn, the card selection depends on the type of analog video and audio sources you have.

Video capture cards are also used to export the edited video to analog storage devices, video tape for example, or to CD/DVD. If you wish to convert your video into the CD/DVD format, appropriate software codecs for compressing video and for conversion of your video to an appropriate format will be required. Besides you would require a drive and blank disks which can support CD/DVD writing.

Fortunately, digital audio and video sources are becoming exceedingly common and match professional analog equipment in quality and performance. Hence, you may wish to resort to digital equipment, in which case, you may at best need to interface your camera or recorder to the computer and copy files.

13.4.4 Camcorder

Traditionally, the two major components of the video recording system, namely, the camera and the recorder were separate units. This imposed various restrictions on their use – two people at least to operate the two units, need to interface them, and work flow management. In a typical studio recording situation, where multiple cameras are used simultaneously, sharing of a recorder made very good sense.
Camcorders on the other hand combined these two units into one. So you had the camera, the imager (usually the CCD or CMOS) for recording the light and the recording media (tape, optical or solid state device) all rolled into one compact unit, making it very easy and efficient for one person to operate.

Camcorders range from very small, lightweight hand held cameras to broadcast quality professional cameras. As we mentioned, they can support a varied range of storage devices, like video tapes, CD/DVD, harddisks and of late, solid state memory disks (also known as flash memory).

![Figure 13.2: Camcorders](image)

13.4.5 Cables and Connectors

The need to upload the recorded video and audio on to the editing unit requires a suitable interface between the two systems. The simplest way is of course to remove the media and play it back in a player connected to the editing unit. But in case you need to connect the camcorder to the editing unit directly, you can do it in one of four ways:

- component;
- composite;
- firewire; and
- USB.

In the case of component, the video signal is analyzed into three separate signals, R-Y, B-Y and Y, where R stands for red, B for blue and Y for luminance or brightness. At the receiving end, either at the editing unit or at the television monitor, these signals are interpreted to yield the information for red, green and blue for the generation of the coloured image. The composite, as the name suggests is a combined (or rather pre-mixed) signal.

The amateur hand held camcorders generally provide a firewire or a USB (or both in some cases). These are purely digital interfaces and used for direct data transfer. In these cases, you would copy an image file from the recording media to the other storage media.

Each of these types of video transfer would require its own kind of cables and connectors, as shown in the Figure 13.3.
It is obviously beyond our scope to study more details about the technological differences between each of these connections, but if you are using a video camera and need to upload video on to a computer, either directly or through a video card (digitise video), you need to be aware of the types of connections available and select appropriate cables for the purpose.

Check Your Progress 13.4

Notes:

a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Describe the typical chain of equipment you would require to develop a video and play it back on a DVD player.

13.5 PROCESS OF VIDEO PRODUCTION

One of the major purposes for this unit was to acquaint you with the potential of video for educational communication. While it is likely that you may opt for using a trained technician or a professional for the technical processes of recording, editing and packaging, a process that cannot be outsourced is the communication.

Only you can define the purpose, the scope and range of content, identify and put together the information you wish to present. Let us briefly examine the ways in which these tasks are accomplished.

13.5.1 Pre-production

Like any communication, you need to plan a video too. Just like a lesson plan, you would identify the objectives, some kind of an introduction, develop the content using appropriate examples, activities, experiments, supporting it with other information which could be graphical (graphs, photographs, drawings, etc.) and speech. You put them all together in to a script, which forms the guideline for the production.
Video allows even more flexibility. Unlike a teacher in a classroom, the video presenter is not fixed in time and space. You can, for example, say, let us examine this crater on Mars, and the visual could be a close up of a Martian crater. You can substantiate your argument or support your information with still images, animation, or video inserts. In order to make your statements authentic, you can also bring in various people to narrate their experiences or present their arguments (straight from the horse’s mouth). And finally you could use music and sound effects. And obviously all of these cannot be achieved in 45 minutes (a typical period in your class). As a producer you would identify the resources, the people, the locations, the logistics, the schedule and equipment to carry out the task. The script would be your guideline.

Video of course has its limitations too. You are not there to catch that bored look on the student’s face and modify your pace, change your example, crack a joke, or even ask the student to wake up! You have for all purposes handed over the remote control. This is where the creative part of the script fits in. A video script is not only a prescription for the technical parts but also a visualization of the scenes and dramatization. Purposefully using it hold the attention of the viewer, get him/her interested and reach out with the message is an art, which would require practice.

13.5.2 Production

This is the part where all the technology is first put to use. This is where the script is translated into an audio-visual medium. While in a professional production, a large number of people and a range of equipment related to light, sound and video could be involved; your production may even involve one camera and one person in front of it. The choice is dependent on the complexity of the script.

All the recording of audio and video is achieved at this stage. For practical reasons, you may have taken repeated shots of the same subject, overcoming errors or shooting from alternate perspectives. If the scene involves people conversing, then you would have a large number of shots, together establishing the conversation, etc. We will not be able to get in to the details here. Suffice it to say that you will have more video than you actually need for the final product.

Care should be taken to record audio which is loud and clear enough to suit the requirements of your script, avoiding all noise to the extent possible.

Systematic planning is very critical to ensure that you have all the shots your script requires. You may not be able to revisit a location, or organize all the people you need again. There may simply not be a second chance. Good producers spend a lot of time reading and re-reading the script, visualising each shot to its last detail and working out all the requirements, well in advance.

13.5.3 Post Production

The final assembly, and trimming of video, adding sound and transition effects, removing noise, adding titles, graphics or other inserts and publishing it on to a CD, DVD or video tape as a finished video product happens at this stage.

Also known as editing, the first step in this process is gathering together all the raw materials or resources you require – the video, the audio, the
Content Creation Tools

In the digital world, the editing process is carried out using editing software. All the resources have to be digitized (using your video capture card) and stored on the hard disk in formats appropriate to the editing software.

Each piece of video – a shot or a clip is previewed many times over, the start and end points noted and sequenced. This process could be achieved on paper or in the case of some editing software, electronically and is referred to as the development of an edit decision list (EDL).

Typically, editing software allows us to work on pieces of video, in any sequence we desire. You could for example complete some part of the video which is in the end and then take up the beginning. That is why such editing is also popularly known as non-linear editing, as opposed to analog tape based editing, where the process had to be achieved sequentially beginning at the very beginning.

Check Your Progress 13.5

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Choosing a relevant instructional situation, explain how a video can be more effective than a face to face presentation.

... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ......
Launch Windows Movie Maker. You should see the following: A task pane listing the steps you need to perform, a collections window, a player window, and a timeline/storyboard window. We would strongly suggest you read the Help Topics under the Help menu before you begin using the software. (see Figure 13.4).

The basic processes involved are creating a collection – a collection of your audio and video files and any other graphics file you need; making a project – a container file which stores information about the sequencing, timing, effects and any modifications in the original clips you have made; and publishing the movie – a final product file which will play back independently in a suitable player software.

You may import video and audio directly from your camera or microphone, or use media files stored on your hard disk or any other storage device connected to your computer. You may use a video capture card, a USB or a IEEE 1394 port to connect your camera or even your sound card to import audio.

The task pane lists the steps you take: 1. capture video, 2. edit movie, and 3. finish movie. Let us look at each of these steps briefly. In our example, let us use video files stored on our hard disk, say in the folder `c:\my documents\my video`. The video files may be in the .avi, .mpg, or the .wmv format. Let us use the .wav files for our audio. For graphics let us use .jpg files (see help topics for other supported formats).

The listing in the task pane works like a wizard, taking us step by step through the movie making process. So let us use this support. Click on import video (if you were importing from the camera, you would opt for capture from video device), select the video files and click Import. Repeat the process for importing graphics (import pictures) and sound (import audio or music). Your collections pane gets populated. Notice the byline –
Drag a clip and drop it on the timeline below. Do just that. Select the clip you wish to place first in the movie and drag it on to the timeline below.

The timeline and story board are alternate views of your project. While the storyboard allows you to view the sequence of clips and any audio, transition effects, or titles, the time line allows you to review or modify the timing of clips in your project. Use the timeline buttons to perform tasks such as changing the view of your project, zooming in or out on details of your project, recording narration, or adjusting the audio levels. You can use the trim handles, which appear when you select a clip to trim unwanted portions of your clip. You can also preview all of the clips in your current project which are displayed on the timeline.

After dragging all the clips on to the time line in the right order (you may reorder them to your heart’s content), zoom into the clips trimming it where necessary or to synchronize it with the audio and to make your movie slick.

Let us now add some captions on to the video. Perhaps these are subtitles in some other language, or the movie’s title or credit titles at the end. There are two forms in which titles appear – one as an independent graphic on its own background, and two as an overlay on the video, like in the case of a subtitle. Go to tools -> Titles and Credits. The titles pane gives you the options – you may add a title at the beginning or end of the movie, before or after a selected clip, or overlay it on a clip.

Let us select ‘Add title’ on the selected clip on the timeline. A new pane with a text window opens, where you may type in your text. Notice, an instant preview is generated in the player pane. Also notice a video effect is already applied to the title. If you are satisfied, click done add title to movie. If not, move down to more options.

You can now change the animation effect or the text effect. Let us change the text. Click on change the text font and colour. The resulting pane allows you to select a new font, a new colour for the text, increase or decrease the font and justify the text in the frame. Notice there is no option for the vertical position of the text. Each of the titling effect comes with preset positions. So, if you are not happy with the position of the text, go to change title animation and choose from among the one line and two line text animations. As you can see an instant preview, you can select the one that suits your need. Finally, click done, add title to the movie.

Now you would like to publish your movie. Go back to the movie tasks pane and open ‘Finish Movie’. You have a variety of options for saving or sending this movie – save on computer, save on CD, send in e-mail, send to web or...
even send to a digital video or DV camera. Let us for now save this movie on your hard disk. When you select this option, a wizard opens to guide you. Select the location to which you wish to save and click next. Now you have options for selecting frame size and quality. The default is best quality and the details of this choice are listed below. Click on more choices. Go to other settings and pull down the options. You will see a very large range of presets. Let us say we wish to finally post this video on our blog and that our audience has slow broadband connections. Opt for Video for broadband (150 Kbps). Notice all the settings change to accommodate this new restriction. Click next, and that’s it; the movie is saved in the destination folder. If you have checked the option play movie when I click finish, you will see a grand play back of your movie.

As in the case of all software, there will be a number of choices available at each step. Do explore them and have fun making movies.

### 13.7 USING WEB-BASED VIDEO EDITING TOOL

Having produced your video, however small or big it is, you would certainly like to show it to others. If you opt for offline methods, you may put it on a CD or DVD. But if you wish to make it available online, you will have to be aware of a few more issues.

As we have discussed earlier, size here refers to the file size as well as the pixel size of the video frame. Internet is still not fast enough to support smooth play back of video. Enthusiasts however have found workarounds. Small stamp size video, a few seconds to a few minutes long placed on a streaming server is adequate to communicate small messages. You will find a large number of such uses on the web. Look up http://youtube.com for instance. Compression formats for video files, for instance, shockwave and flash video are also being used to deploy banners and even tutorials.

![Kaltura – an online video editing facility](image)

**Figure 13.6: Kaltura – an online video editing facility**
Having worked out an optimum size for your video file, finding a place to host it will be the second challenge you need to address. Web servers use media servers (software capable of serving audio or video) to service requests for playback of video. Flash media server, Real media server, etc. are commonly used in the windows domain. Not only is the preparation of your video for web hosting an involved task, but web hosting charges can also be steep. Before you learn to cope with the technological requirements, you should try this out.

While a search for “free hosts for video” on a search engine like Google will yield a number of sites willing to host your video, utmost discretion is required, as many of these sites earn their revenue hosting undesirable or adult content.

One of the sites, we recommend is Kaltura (http://corp.kaltura.com). This is an open source video platform, where you can upload your raw video, edit and then publish it for online viewing.

This site provides a free trial service to a limit (10GB) and offers to upgrade you to a paid service thereafter. The free trial includes 10GB of hosting & streaming. A simple calculation will show that this is actually not much if you have a lot of video or a lot of clients. If you have a 1MB video and about 100 people viewed it every day, you would have used 100MB each day. 10GB is hundred times this figure. That is, if you host 100 files of about 1 MB each, and 100 people viewed each of these videos, then your trial offer is over in a day.

But the purpose of this exercise is not to provide you with a web hosting option for your videos, but to demonstrate a capability of the web and help you explore the technology associated with video post-production and hosting. So, we will assume, that you have a few videos of a few MB each, for the trial. The proposed video activity can be quite effectively completed within the trial period.

As the first step, sign up for a free trial. This involves filling up a form on the Kaltura site and providing a few details. Once you are a registered user, you are given access to Kaltura’s tools. The first task would be to gather together your raw audio, video and photographs, a process called ingestion. Kaltura handles a variety of formats for each of your media. This application also allows direct upload from a web camera or microphone and even from VHS video players. This is a straightforward step, where you browse your hard disk or the web, select the files and click on upload (see Figure 13.7). Once uploaded, you can add keywords and other descriptors, which will help you organise and users search for your video.
The second step is to compose your video, a process that requires you to work with a video editor. Kaltura’s video editor comes in two forms, one straightforward one, which is somewhat similar in functionality with Windows Movie Maker and a more premium version, where you can work with advanced features and modify your audio, video or photographs, apply transitions and effects, add subtitles in a variety of ways, etc. (see Figure 13.8)

Kaltura’s Video-PowerPoint® Widget allows you to synchronize video with PowerPoint® slideshows, add subtitles and captions in any language to any type of web video, delivering a rich contextual multimedia experience (See Figure 13.9). The special feature of these subtitles is the facility to select a preferred language for the subtitles, which means you can simultaneously cater to different language groups.

The next steps are relevant when you are ready to host the video on your web site or run a course or forum, in which the video is integrated. Then you need to get into managing your videos, decide on how to stream them, and ways to embed the video (what player, how will it look, what will be the controls, etc.) on the web page. You will learn about websites and content management systems in later units. Revisit this unit when you have experienced video on the web.
Again, as we have mentioned time and again, all the features cannot be exhausted in such a unit. Do try this online video editing software and explore its wide variety of features.

13.8 LET US SUM UP

We present to you below a brief summary of discussions in this unit:

- With advances in technology video has become a very popular medium for audio-visual communication. The advent of digital video and its processing on normal desktop computers and miniaturization leading to small hand held camcorders have been mainly responsible for this popularity.

- Cinema is based on recording images on film and playing it back rapidly enough to simulate real time motion. Video and television on the other hand use a scanning of a stream of electrons across a photo sensor while recording and a phosphorescent screen while displaying images.

- This scanning process has a bearing on various parameters such as aspect ratio (size of the video frame), colours and their range, recording and playback, digitization and transmission of video signals.

- Analog video can be converted into digital video using a video capture interface. Once digitized, video can be stored as a digital file in a variety of formats. They can also be converted from one format to another using appropriate converter. Digital video can be stored on a variety of media like video tape, CD/DVD, hard disks and flash memory devices like memory sticks, etc.

- Digital video formats are selected based on the purpose of the video and the storage and transmission medium. Broadcast video has the highest resolution and hence the highest file size. Video for the web uses the highest compression and small image sizes, making it suitable for playback on low speed internet connections.

- Video communication is a creative medium and calls for a range of abilities. Developing a communication on video requires systematic planning, organizing, production and post production activities, requiring a range of educational, technical and professional skills.

- While professional video production is an involved process, you can also use small hand held camcorders and a computer based software to compile, edit and produce an amateur video communication. Software like Windows Movie Maker has features designed for the amateur video enthusiast. You may use an online facility like Kaltura to develop web ready video.

13.9 KEYWORDS

Firewire: FireWire is Apple's name for the IEEE 1394 High Speed Serial Bus.

Frame rate: or frame frequency, is the frequency (rate) at which an imaging device produces unique consecutive images called frames.

Interlace: is a technique of improving the picture quality of a video signal without consuming extra bandwidth. It uses progressive scan of the pixels in the screen.

Resolution: is the number of distinct pixels in each dimension that can be displayed in a computer screen.

Streaming video: is content sent in compressed form over the Internet and displayed by the viewer in real time.
**Video capture card:** is a class of video capture device designed to plug directly into expansion slots in personal computers. It is also used for converting analog signal into digital format.

**Widget:** is a portable chunk of code that can be installed and executed within any separate HTML-based web page by an end user without requiring additional compilation.

### 13. 10 REFERENCES AND FURTHER READINGS


### 13.11 FEEDBACK TO CHECK YOUR PROGRESS QUESTIONS

**Check Your Progress 13.1**

A cathode ray tube (CRT) produces a constant beam of electrons which when obstructed by a fluorescent or phosphorescent screen produces a luminous dot. Using colour sensitive phosphors, red, green or blue dots are produced. The scanning process progressively moves the beam across the screen, retraced back to the beginning, a step down and the tracing begins again. This way the entire screen is painted. Once it reaches the bottom edge of the screen, the beam is taken back to the top and the process begins all over again. This process happens very rapidly (in about one-twenty fifth of a second) simulating a continuous image.

The number of dots created on the screen and their spacing are related to the sharpness of the image. The speed (25 frames per second) lays an automatic restriction. Processes happening faster than this cannot be shown normally.

**Check Your Progress 13.2**

The number of phosphor dots available per inch of monitor space defines how closely packed the pixels of the image would be. The number 640 x 480 signifies a matrix of 640 columns and 480 rows of pixels. All these dots together make up the image on the screen. When a bitmap image of say 640 x 480 size is displayed on a monitor of a higher resolution, say 1024 x 768, it will be displayed in a smaller window of size 640 x 480. If blown up to full screen, the same number of pixels will be smeared out over the larger area, making the image lose its resolution.

**Check Your Progress 13.3**

The internet facilitates communication of digital data at varying speeds. So if you have a broadband connection, which under ideal conditions transmits 512 Kbps, you would be able to receive close to 512 Kilo Bytes each second. You can work out based on what you learnt in the unit, how much data you wish to receive if smooth playback of video is to be ensured. Obviously, Internet is still not fast enough to video broadcast. Factors like image size, compression, format and the speed of the internet connection and the capacity of the server will affect the quality of download and consequently the quality of playback of the video.
Check Your Progress 13.4
We can visualize the chain by categorizing the process thus: production, post-production, packaging, and playback. Once you have a systematic script worked out, you record video, supporting audio, music and sound effects, and any graphics required. This part would require at least a video camera. You may use external microphones, lights, etc. based on the requirement. All the recorded content is put together into a coherent video communication on an editing machine. This would typically be editing software residing on a computer. You may also need a video capture card if you had used analog video. Once the post-production process is complete, the final video presentation has to be subjected to two processes. One, it has to be suitably compressed and converted into the DVD format. Editing software has built-in facilities for this. Two, it has to be recorded on to a DVD. Your computer should therefore be equipped with a DVD writer drive.

Check Your Progress 13.5
Typically, we would prefer video where there is something to show. Also something that cannot be communicated in a still image – a process, an event, etc. The event itself could happen normally over a relatively long time. Further let us assume that watching the video itself does not suffice, but needs further explanation. This could be through an explanatory commentary. It could also need other data, or graphic or simply a labeling of parts. Select a subject and instructional situation which requires all of the above. Then describe how even if possible, it would be difficult to manage, in a face to face situation without the support of video. Also describe how the video itself functions as a time saving device.
UNIT 14 INTERACTIVE MULTIMEDIA

Structure
14.0 Introduction
14.1 Learning Outcomes
14.2 Interactive Multimedia
   14.2.1 Characteristics
   14.2.2 Strengths and Limitations
14.3 Theories in Interactive Multimedia Design
   14.3.1 Cognitive Load Theory
   14.3.2 Dual Coding Theory
14.4 Principles of Interactive Multimedia Design
14.5 Scripting for Interactive Multimedia
   14.5.1 Elements of a Storyboard
14.6 Software for Multimedia
14.7 Evaluation of Interactive Multimedia
14.8 Let Us Sum Up
14.9 Keywords
14.10 References and Further Readings
14.11 Feedback to Check Your Progress Questions

14.0 INTRODUCTION

Information and Communication Technologies (ICTs) have touched every sphere of life. Technologies have always brought significant changes in human lives. ICTs are also affecting human lives in many ways. If we focus on positive aspects of these technologies, we realize that almost every field of a civilized life is enriched by ICTs. It may be our financial transactions or traveling facilities, or it may be 24 hours available entertainment, ICTs plays a major role in our life. If we exploit every new technology to enrich our lives in all possible ways, where are we in the field of teaching and training? Does an Indian learner use computerized educational material to the extent to which s/he uses computer for playing games, sending emails to friends and posting on online communities such as Orkut and Facebook? Does the number of quality educational multimedia exceed the number of available CDs and DVDs of songs, videos and games?

If the answer is “No”, then that means teaching-learning field is not exploiting available technologies effectively. As significant and responsible contributors of the field of education, we need to develop effective interactive material for our learners, so that learners can spend quality time learning and comprehending complex concepts and skills. Let us discuss here how we can be skilled in this area of computerized interactive learning material.

14.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:
• Define interactive multimedia (IMM);
• Describe the advantages of multimedia;
• Explain the principles of designing educational multimedia; and
• Evaluate interactive multimedia resources for learning.
# 14.2 INTERACTIVE MULTIMEDIA

<table>
<thead>
<tr>
<th>Box 14.1: Ms. Swara’s class</th>
</tr>
</thead>
</table>
| Ms. Swara wanted to teach geometrical shapes to her third standard students. She had an innovative idea in mind. She took help of her sister who is an animator and brother who is multimedia developer. They all spent a lot of time and developed a multimedia package.  

The package starts with a page which has different geometrical shapes on the first screen. Once clicked on any of the shapes, a new module opens which is meant for learning that shape. e.g. If learner clicks on shape of ‘cylinder’, a module on ‘cylinder’ opens. A cylindrical cartoon jumps and starts talking to learners. Many objects of the cylindrical shape appear and start giving information about this shape. Many games and activities based on the module appear on many of the screens. Children could learn the topic with enjoyment. |

Multimedia, as the term suggests, is combination of media. It is the use of multiple types of media, i.e. audio, video, graphics, animations and text, within a single desktop computer programme. In other words, multimedia means the processing and presentation of media in two or more media. Kjelladahl (1992) defines multimedia in terms of representation and communication of information. According to him, multimedia is text/natural language, pictures (including symbolic graphics, cartoons, animations and both still and moving real world images) and sound (speech and ambient).

Though multimedia is a combination of two or more media, it is not just mixing of media. Vaughan (1996) uses the term “woven combination”. According to Ravet and Layte (1997), the quality of a multimedia package depends on what is combined and how. The critical factor would be the way in which the media are made to work together to create an ‘elaborated whole.’

Now let’s think about difference between a mere slide-presentation and an interactive material as described in Box 14.1. Interactivity is the extent to which one can interact actively. Mere linear presentation cannot provide interactivity.

According to Mitra and Mitra (1998), “Teaching programmes of the future will detect a student’s learning style, psycho-social characteristics, physiological limitations and other parameters important to learning. It will then use its experimental data about other students it has ‘taught’ to decide on a teaching strategy. Finally it will reach into its bank of educational materials to find appropriate content for the teaching task at hand.”

Interactive teaching strategies may involve a range of activities to engage learners. These include making choices and decisions, composing, taking notes, and making evaluations and judgments, constructing, drawing and controlling. (Allessi and Trollip, 2001) Interactive educational multimedia is the multimedia, which gives active learning experience. This active learning may not mean only choosing modules, browsing or navigating but it should give chance to stimulate thinking and taking prompt decisions. Interactive multimedia should ask for learner’s response based on the comprehension of content and provide immediate feedback so as to check learner’s progress.

To quote Perrin (1991), “Interactivity is NOT pressing a key to advance to the next page. Interactivity requires meaningful feedback to each learner response leading towards an essential goal”.

Interactivity of this kind can be achieved in many different ways. Following guidelines for increasing interactivity in multimedia programmes have been summarised by Stemler (1997):
1) Provide opportunities for interaction at least every three or four screens or, alternatively, about one per minute.

2) Chunk the content into small segments and build in questions (with feedback), periodic reviews, and summarise for each segment.

3) Ask as many questions as possible without interrupting the continuity of the instructional flow. Ask a question after, but not immediately following, the related content. Ask students a question that they can answer based on previously learned knowledge. Ask students to apply what they have learned rather than memorise and repeat answers.

4) Use rhetorical questions during instruction to get students to think about the content, to stimulate students’ curiosity, and as a natural transition between frames.

5) Consider designs where the learner is not presented with information in a linear format, but rather discovers information through active exploration in the program.

14.2.1 Characteristics

Interactive Multimedia as a self-instructional mode possesses some characteristics, which resemble with the characteristics of programmed instruction and self-instructional modules in open learning. The characteristics of interactive multimedia are:

1) **Specific Target Group**: Being an individualized instructional mode, IMM is developed for a well-defined target group after analyzing characteristics of the group. Content, language, examples, illustrations, cultural details, volume of explanation and also multimedia inputs (e.g. sound effects, animations) need to be designed specially for the defined target group.

2) **Specific Objectives**: Terminal behavioural objectives are specified as a first step towards the development of IMM. It is followed by developing evaluation tools to assess the learner with reference to these objectives. Defining objectives, thus, ensures reliable learning results.

3) **Content in Small Chunks**: IMM presents content in the form of very small steps at a time. IMM proceeds with the next chunk only after assuring comprehension of that concept or information or skill. This step-wise learning helps learner to attain mastery over the content. The content is sequenced using maxims such as from simple to complex, concrete to abstract, examples to rules/concept which help in better conceptualization and comprehension.

4) **Learner-controlled and Adaptive mode**: IMM provides optimum control to the learner. It can be designed in such a manner that progressing to the next step, navigation facility, access to sub-modules, selection and speed of multimedia inputs like audio, video, and even the mode of learning (presentation or simulation or drilling) can be controlled by the learner.

5) **Interactivity**: As a self-instructional strategy, IMM, as the name suggests, is also activity-oriented strategy seeking frequent and unambiguous response from learner at every step. IMM can provide for active response in terms of question-answers, solving quizzes, puzzles as other non-computerised material may provide. Apart from this, IMM can create environment for creative and experiential learning through modelling and simulation mode.

6) **Immediate Feedback and Reinforcement**: Being an electronic device, IMM provides immediate confirmation of every response of learner. A well-designed IMM provides corrective feedback to the learners that
help in effective learning. Reinforcement techniques with attractive multimedia strategies enhance motivation level and sense of accomplishment at every small step. IMM may also arrange for clues, help, instructions for explorations and ultimately reward the learner for her/his adventures.

7) **Validated Programme:** IMM is generally prepared for wider use and therefore, needs to be validated. Empirical validation of IMM assures for its accuracy. IMM also generally covers optimum content with adequate information, extensive illustrations and wider scope for practice.

8) **Multimedia Elements:** Multimedia inputs such as graphics, animations, sounds, video make IMM motivating which arouse and maintain learners’ interest to a great extent. Apart from being interesting, it can be more informative and elaborative. Being a combination of media, IMM becomes self-explanatory and appealing to more than one sense. It can create a virtual world for learners to play, explore and experiment in. Rare and complex experiences such as working with microscopic elements, three-dimensional objects, experiments involving risks, universal objects, complex processes can be made available through IMM.

9) **Advanced technology:** Advanced technologies such as digital video, simulations add to the effectiveness of IMM. IMM can provide for easy access to the wealth of support material such as net-based archives, museums, databases, reviews, glossary, etc. In brief, Interactive Multimedia can bring in a revolutionary change in the field of education, if designed carefully and systematically.

### 14.2.2 Strengths and Limitations

**Strengths**

If we consider all major characteristics of interactive multimedia we can identify strengths of this kind of material offered to us due to each of the characteristics. Let us perform an exercise. Table 14.1 gives strengths of interactive multimedia based on the characteristics.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Strength of IMM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Learner–controlled material</strong></td>
<td>It allow learner to learn by its own pace. Active learning helps learner to comprehend the concepts in better way.</td>
</tr>
<tr>
<td><strong>Interactivity</strong></td>
<td>Interactivity keeps learner active throughout the learning process and makes the learning more meaningful. It helps in better understanding and retention.</td>
</tr>
<tr>
<td><strong>Validated Programme</strong></td>
<td>Since the IMM are validated by implementing on a large sample of learners, it assures quality and accuracy of the material. Expert validation discards chances of errors.</td>
</tr>
<tr>
<td><strong>Multimedia Elements</strong></td>
<td>All multimedia elements enable multi-sensory learning. It helps learners to visualize the learning experiences and makes learning concrete.</td>
</tr>
<tr>
<td><strong>Advanced technology</strong></td>
<td>Advanced technologies allow us to provide varied and more relevant experiences. It allows game mode and simulation mode possible. Learners can themselves explore and experiment with the help of the advanced technologies.</td>
</tr>
</tbody>
</table>
Limitations

Even though interactive multimedia material is proved very effective in learning, the media itself has some limitations. If we understand these limitations, it will help us in planning for the use of this material in the teaching-learning process.

*Let us discuss a few limitations.* Which of the following objectives/skills, do you think can be best learnt by using interactive multimedia packages?

a) Measuring angles  
b) Properties of Magnetism  
c) Constructing triangles  
d) Latitudes-Longitudes  
e) Volcano  
f) Swimming with backstrokes  
g) Freedom struggle in India  
h) Removing puncture of a tyre  
i) Developing respect for elders

If you think that developing multimedia for a, b, d, e and g will be more meaningful, you are absolutely right. Packages for the skills mentioned in c, f and h require of support actual practical experience. Attitudinal change and value-development can be supported and promoted by effective packages, but it is a long-term process and these objectives may not be achieved by using one-hour multimedia. Thus, we can conclude that many skills in affective and psychomotor areas need experiences other than IMM. We also need to remember here that many innovations are being done in this area to develop some skill-based software supported by real-like simulations. Simulated machines are used for skill-development.

A major limitation for use of IMM is the infrastructural facility. Though IMM prove very effective in learning, it is always assumed that learners will be provided computer systems for using these IMM packages. Reaching to unreached can be achieved only by providing them computer systems as well as electricity if we wish to give them exposure through IMM. Before making this an issue wherever experts discuss uses of computerised material and e-learning resources, we also need to remember that there are many children and schools equipped with such infrastructure, but lack quality material. Today children are using available computer systems just to play games and to learn topic from computer education such as DTP and programming.

Development of quality multimedia material is teamwork. As you will proceed through this module, you will understand the developmental process in detail. At the end of the module, you will agree that it is a teamwork and involves cost. If planned and implemented thoughtfully, institutes can make the whole exercise cost-effective, otherwise development of IMM is an expensive affair. Collaboration within institutes will always prove beneficial in this area.

We may thus conclude that though there are a few limitations to IMM, one can find ways and solutions to overcome many of these limitations. These limitations may not hinder the thought of using such material in the teaching-learning process.
Check Your Progress 14.1

Notes: a) Write your answers in the space given below.
          b) Compare your answers with the ones given at the end of this Unit.

1) Define interactive multimedia in your own words.

2) List five characteristics of multimedia.

14.3 THEORIES IN INTERACTIVE MULTIMEDIA DESIGN

Before we discuss how to develop the kind of material Ms. Swara (Box 14.1) developed for her learners, we need to discuss the theoretical and psychological aspects of human learning and human cognition. These aspects need to be considered while planning for multimedia learning activities. Two major theories in the field of human cognition which help us in designing multimedia are: Cognitive Load Theory; and Dual Coding Theory. Let us discuss each of these theories in detail.

14.3.1 Cognitive Load Theory

The moment we use the term “Multimedia”, we accept that more than one medium are being used in the learning material. We need to think whether these multiple media are going to burden our learner’s cognition. How does a human being receive and process information? Is multi-sensory information processed simultaneously? Does it affect smooth cognition?

Let us see what Cognitive Load theory says about this. Our working memory has limited capacity. If a lot of information is needed to be processed, this memory experiences cognitive load. New media experiences may engage learners in getting excited about these varied experiences. This excitation affects comprehension of the real learning content.

Box 14.2: John’s Science CD

John’s father has bought him beautiful multimedia packages for learning concepts of Science. The package has an interesting laboratory environment. This is not a common lab, but a fantastic lab full of exciting magical devices. A few animations running continuously on the screen make John stuck to the package. He loves the way Prof. Magnofician, the Scientist as a narrator speaks in the package. Sound effects used are also enchanting.

John is very happy with package. What his father found is John loves to view the package with a lot of pictures and animations, but he can hardly “learn” anything out of it. He hardly concentrates on the content.
Many multimedia packages have the limitation described in Box 14.2. Multimedia developers design beautiful graphical scenarios. Sometimes these graphics are so attractive that the attention is focused on the graphics rather than the content. If we plan a continuously running animation on the screen, learners experience cognitive load and that affects their comprehension. Too much of text can also work as a load. Brief and precise information, attractive but non-crowded screens, pleasant and logically arranged screen-designs help reduce this cognitive load on the learner. If the entire screen is full of scenario, text used on the screen should be distinct and very clearly shown on the background. Semi-transparent text-boxes or converting scenario background in the water-mark helps in such cases.

User-control is considered as a major strength of an IMM. The feature of user-control needs to be carefully exploited. If a user lacks previous knowledge or is still younger to use various choices provided in the user-interface, access user-control may confuse the learner, e.g. if a drop-down menu is provided on each screen for a small child, it may click the drop-down menu and enter into an another module unknowingly. The child will fail to understand how s/he has entered into the other module. This does not mean that there should always be fewer choices for interaction. Once a mature learner gets used to exploit choices provided for interactions, makes maximum use of these choices. The learner gets used of these choices and hence using various choices becomes part of his/her long-term memory.

14.3.2 Dual Coding Theory

Though psychologists caution us about Cognitive Load Theory, they also make us aware of dual coding function of our brain. It may appear after learning Cognitive Load Theory that multimedia itself is responsible for cognitive load and hence should not be used. Dual Coding theory tells us how our cognitive abilities process visual and verbal information simultaneously allowing us to learn from rich experiences. Our working memory possesses two compartments of processing, one for verbal and the other for non-verbal information. It, therefore, processes both types of information simultaneously. The information needs to be related to each other and supplementary. For example an animation can be run along with its audio explanation. It should be remembered that new text and changes in an animation can not be ‘viewed’ simultaneously, but if an audio is run, explanation of content can be heard as well as seen.

More than one medium helps learner in cognition as it provides food for the visual and verbal compartments. Many a times, we go on explaining a particular concept or phenomenon till the learner understands it completely. The learner, here, needs to comprehend lengthy explanations and retain such a lengthy verbal explanations in his/her working memory. A still graphical representation of the same knowledge or a smaller movie/animation, however, becomes less in terms of time-duration and helps the learner retain the knowledge in the working memory. On the other hand, pictures without labels or brief information may not help learner to understand the content. A brief verbal input may help the learner more. Thoughtful combination of verbal and visual inputs will thus prove more effective.
If a complex picture or animation is presented along with a long text, it causes split-attention effect. Presenting pictures in parts along with only a few related textual explanations will help learner comprehend the concept. Dual Coding theory, thus, helps the designer to use and arrange visual and verbal elements thoughtfully allowing learner to comprehend and retain new knowledge.

14.4 PRINCIPLES OF INTERACTIVE MULTIMEDIA DESIGN

Once decisions regarding content are taken by the instructional designer, story-board writer needs to arrange multimedia elements carefully. We will discuss some of the principles of multimedia design evolved out of the research work done by Mayer (2001, 2005) and others.

Multimedia Principle: Use words and graphics rather than words alone.

---

Magnetic Keepers

Magnetic Keepers are used to prevent the loss of magnetism from the magnets.

Magnets are kept in pairs with their opposite poles facing each other. Pieces of soft iron strips called 'Keepers' are then placed across these poles.

These 'keepers' help to complete the magnetic circuit, thus, keeping no free poles to lose their magnetic strength.

Figure 14.1: Text and Graphics

Figure 14.2: Text alone
Which of the figures (14.1 or 14.2) helps more in understanding the meaning and role of Magnetic keepers? Certainly, use of text in combination with graphics leads to better learning success than using text alone. So, the visualization of content along with the verbal explanation should be used at maximum.

**Modality Principle: Include speech to explain.**
Use of audio to explain graphics instead of mere on-screen text enhances understanding the visual element. It helps in expanding cognitive resources to simultaneously tap both visual and phonetic memory.

**Redundancy Principle: Use audio to explain an animation sequence rather than on-screen text**
Learners learn better from animation and narration than from animation, narration and on-screen text. Appearance of on-screen text while the animation is run, distracts learner and thus s/he may ignore the written content. When eyes are engaged viewing animation, it cannot be engaged in reading on-screen text simultaneously. Instead, audio may allow the learner to focus on the animation sequence while listening to the corresponding audio.

**Coherence Principle: Adding interesting material can hurt learning.**
Avoid using unnecessary texts, graphics, animation or sound in IMM only for the sake of making it attractive and decorative. Unrelated, decorative material distracts the learners from the actual learning objective. It not only distracts the learner, but also hinders the process of interpreting and comprehending the content.

**Contiguity Principle: Place corresponding words and graphics near each other.**
If text and related visuals are placed at separate places, learner needs to utilize its time and energy to search the related graphics. The cognitive efforts of relating corresponding elements are referred to as “extraneous processing”. While understanding the content, learner needs to shuffle between the textual content so as to refer to the graphic. If the content is explained using more than one screen, repeat the graphic element to avoid this shuffling. Even referring to previous graphic should be avoided while discussing a new graphic element. The previous graphic should be repeated again and placed near the new one instead.

The principle also applies to the question, learner’s response and its feedback. Let us also not forget to place directions for an exercise in the same frame available for the exercise (See Figure 14.3).

You can see that the screen in fig 14.2 presents steps of the procedure right beside the graph image. The questions asked about the image are presented beside it so as to interpret for responding. Even feedback appears close to the responses.

This principle may lead to cluttering the screen. Cluttering may be avoided by use of pop-ups and breaking of text into more screens keeping the graphic element constant.
Segmentation Principle
People learn better when information is presented in bite-size segments. Break the content into small chunks. Procedures should be broken into separate screens for individual steps. This helps learners to follow instructions one by one. Comprehension of each small chunk also becomes easier in case of knowledge content. (Refer to Figure 14.4).

Practice Principle: Use of practice improves learning
Till the learner is actively engaged in the learning process, one cannot guarantee learning. Immediately after the new content is presented, learner should be put in an interactive situation where s/he will respond to the questions, exercises and/or activities. This will ensure comprehension and also allow learner to apply the learned knowledge and skills. (See Figure 14.5).

We also need to remember not to present the entire content without any interaction. Apart from learning activities, practice exercises should also be distributed throughout the content instead of giving all exercises at the end of a module. The quantity of the exercises should depend on the nature (complexity) of the content. More practice questions for an easy content will demotivate the learner, whereas complex content will require adequate practice.

Personalization Principle: Use conversational style.
Your material is easier to understand when you address the readers directly. This increases personalization and helps learner to overcome feeling of being isolated. The IMM should create an environment in which the learner would feel interacting with the teacher.
Figure 14.4: Steps of the experiment on “Reflection of Light” *(Courtesy: MKCL, Pune)*
In figure 14.6, instead of writing, “e.g. Sunlight shining through a small gap or hole into a dark room”, the package asks a question to the learner making him/her recall a similar experience.
Check Your Progress 14.2

Notes: a) Write your answer in the space given below.
      b) Compare your answer with the one given at the end of this unit.

Write True or False.

a) While designing multimedia, related graphics and words should be places near each other.

b) It is better to use animation, narration and text rather than animation and narration.

c) Information in a multimedia be presented in small chunks.

d) Interactivity in multimedia increases cognitive load.

f) Too much of graphics or text on screen increases cognitive load.

g) Dual coding theory support modality principle.

14.5 SCRIPTING FOR INTERACTIVE MULTIMEDIA

By now you might have realized that designing an effective interactive multimedia package keeping the principles in mind is not an easy task. It requires team-work and extensive planning.

A lot of analysis is required for the actual design and development of IMM. Once the analysis of need of the learners, content/task and resources is done, design phase starts with the identification of objectives and finalization of content-outline alongwith the flow-chart.

The final stage of the design phase is script-development phase. Let’s discuss this stage in detail as it involves actual design process before development of the package on computer. Script-writing may be done in two steps: Designing Storyline, and Designing Storyboard

Designing Storyline

Storyline is a continuous story developed as per the decided flow of content. Storyline mentions the instructional strategy we are visualising for a particular storyboard. Many a times experienced creative teachers and subject matter experts possess excellent ideas regarding treatment to a topic. Even though the teacher knows how the concept can be explained differently, s/he may not know how to write storyboard for the multimedia development team. It becomes easier for such a person to write storyline. The storyline gives us how the subject/content shall be treated in presentation.

Designing Storyboard

Storyline is further translated into storyboard. A storyboard is a document that contains sequential detailed description of the screens for the visualized interactive multimedia. A storyboard is referred by the entire project development team thereafter. Storyboard specifies development responsibilities for each one from the multimedia team. Hence, precise detailing of every screen is crucial in storyboarding.
Storyline is an essay-type document describing the flow of sequence as per the visualized treatment, whereas storyboard has a format with place for many elements, mainly the multimedia elements.

### 14.5.1 Elements of a Storyboard

**Activity 14.1:** If the storyboard is a document which is referred by a multimedia development team, what should be the main elements of any storyboard in your opinion? Tick mark the elements you think should be included in a detailed storyboard.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Objectives</td>
</tr>
<tr>
<td>2)</td>
<td>On-screen Text</td>
</tr>
<tr>
<td>3)</td>
<td>Description of Graphics</td>
</tr>
<tr>
<td>4)</td>
<td>Blue-print for tests</td>
</tr>
<tr>
<td>5)</td>
<td>Details of audio effects and voice-over</td>
</tr>
<tr>
<td>6)</td>
<td>Description of Video</td>
</tr>
<tr>
<td>7)</td>
<td>Menu page</td>
</tr>
<tr>
<td>8)</td>
<td>Description of Animation</td>
</tr>
<tr>
<td>9)</td>
<td>User Interface Design</td>
</tr>
<tr>
<td>10)</td>
<td>Content analysis</td>
</tr>
<tr>
<td>11)</td>
<td>Sequence of multimedia components on each screen</td>
</tr>
<tr>
<td>12)</td>
<td>Instructions for Interactivity</td>
</tr>
<tr>
<td>13)</td>
<td>Feedback</td>
</tr>
<tr>
<td>14)</td>
<td>Instructions to users</td>
</tr>
<tr>
<td>15)</td>
<td>Learner analysis</td>
</tr>
</tbody>
</table>

**Note:** 4, 10, 15 are not required.

Storyboard is the final output of the design phase. If you reflect on the analysis and all tasks till designing storyline, you will realize that we do not need analysis details to be reworked at this stage. The final design is handed over to the development team and they will simply develop multimedia by referring to the storyboard. They may not be interested in all analysis details. Storyboard is a guideline for all members of the development team including editors. If we visualize needs of a multimedia development team, then the following elements of the storyboard can be identified:

- **Text:** Text in the storyboards includes text of content which you wish to show on multimedia screens. It also includes instructions to be displayed for the learner. There may be labels of diagrams. Readable, precise and user friendly text will make the package effective. Instructions regarding placement and sequence of text appearance also need to be mentioned.

- **Graphics:** Though the storyboard writer is not expected to draw required graphics, s/he needs to describe the intended graphic so that the graphic designer draws or obtains the same. Photographs can be downloaded from open resources if the multimedia is not aimed at commercial use. Rough sketch of the graphic always helps graphic designer to visualize idea in the mind of the writer.

- **Audio:** Audio in the multimedia may be voice-over of the text on the screens. Other than reading text, audio can be used for oral instructions, music, sound effects, etc. Writer needs to specify audio elements so that multimedia developers acquire the same or get those recorded.
Interactive Multimedia

- **Animation**: All of us know that animations are powerful tools in the hands of teachers. Wherever writer visualizes animation sequences, need to describe the same extensively so as to enable animators create accurate and effective animations.

- **Video**: Many a times, video of real situation proves more effective than the animations. These videos can be recorded if the writer describes his/her expectations.

- **User Interface Design**: General screen layout, arrangement of title bars, navigation buttons and position of text, graphics and animations can also be suggested by the storyboard writer.

Briefly, a storyboard is a document that contains sequential detailed description of the screens that will constitute the instructional unit to be developed. Requirements per screen are mentioned in the storyboard. Elements such as text, graphics, animation, audio and video are provided in any storyboard.

While writing a storyboard, the following precautions are necessary:

1) The concept should not be presented in a deductive manner. The learner should be given an opportunity to derive concept by viewing examples, solving small assignments based on these examples, deriving common characteristics, etc. The definition of the concept would naturally emerge as a result of various exercises done by the learner. It should be assured that the learner has learnt, comprehended the characteristics of the concept and then s/he comes across the definition.

2) Each frame should contain a small chunk of information or a small activity. A single frame should not contain more than one content-point.

3) Language of the script should be interactive in nature. Language should be conversational and appealing. Authoritative way of delivery is not advisable. Analogies about day-to-day experiences and humour are useful.

4) Illustrations should be widely used. Mere abstract, theoretical information need not be presented through multimedia instruction. All elements of multimedia should be exploited for explaining the content. Use of appropriate graphics, animations, video and sound make the multimedia effective.

5) Language of the multimedia package should be simple. Passive structures should be avoided. Simple vocabulary and simple structures, small sentences, small paragraphs make the multimedia package readable.

6) Interaction is the keyword of an effective self-instruction. Frames of multimedia should not look like the pages of electronic book with colourful text and pictures. Every sub-unit must include some activity requiring learner’s active response. Activities and exercises keep the learners busy, compel them to try and comprehend the content and apply the same to newer situations, sustain their attention and keep their thinking process and creativity working.

### 14.6 SOFTWARE FOR MULTIMEDIA

Software or authoring system to develop multimedia depends on the nature of the package planned. These packages can either be developed by skilled programmers or expert multimedia developer. Depending on the requirements, we may need:
Content Creation Tools

• Graphic designer,
• Programmer,
• Data-entry operator,
• Audio-editing expert,
• Animator,
• 3-D Modelling expert, and
• Multimedia developer.

As mentioned above, programming expert can develop a package using programming language and scripting such as Visual Basic, Java, etc. A multimedia developer may not be expert in programming languages, but may be skilled in using ready multimedia development packages. Software such as Blender, Flash, Authorware, etc. are useful for the development tasks. We need a few more software for graphic-design, photo-editing, audio-editing, animation-creations, 3D Modelling and complex systems for simulation designs. The more our script is complex, the more expertise we need. You will now agree that multimedia development is a team-effort. Mere presentation-development skills are not useful for development of interactive multimedia and hence teacher may depend on such a team instead of trying to acquire all skills themselves. Truly interactive package development is a time-consuming task and teachers need not spend their time in the actual development. Effective script-writing is, however, needed today for our learners and if teachers develop skill of writing good scripts, it will contribute significantly to this ICT-driven society.

14.7 EVALUATION OF INTERACTIVE MULTIMEDIA

The last stage of development of any material for wider use is evaluation. The evaluation of any interactive multimedia to find out its effectiveness is done at three levels:

1) Assessment of learners after learning through interactive multimedia;
2) Evaluation of interactive multimedia by experts in the relevant fields, i.e. subject matter experts, multimedia experts and instructional design experts;
3) Reaction of learners to the package.

Assessment of learners after learning through IMM

All IMM’s are designed in light of some well-defined objectives. We need to evaluate the IMM in light of the same objectives. This can be achieved by assessing learner performance after learning through IMM.

Determining assessment guidelines is very important. Jolliffe et. al. (2001) mentions the following reasons for providing tests:

• To give objectivity to observation;
• To elicit behavior under relatively controlled conditions;
• To sample performances of which the learner is capable;
• To obtain performances and measure; gains relevant to goals or standards
• To apprehend the unseen or unseeable; i.e. person’s attributes, values or developmental levels.
• To detect the characteristics and components of behavior;
• To predict future performance;
• To make data always available for feedback and decision making.
Assessment strategies for learners can be planned as a part of the package and/or a set of tests can also be prepared other than the IMM. Questions, activities, quizzes embedded in IMM or after every section provide immediate feedback about how much is achieved by the learner during the learning process.

If tests are planned after every session, the learner can be guided at the end of the session about her/his mastery of that sub-content. The learner may be guided regarding the need for revision. Pre-tests also can be embedded in the package at the entry point of each module which would not allow learner to learn a particular module if entry level objectives are not achieved already.

A final test at the end may reveal the learner about her/his overall mastery over the content or the task and guide her/him whether s/he should proceed with the next topic or revise the same again. A written or oral test would test the retention of the content it given after a short period.

**Evaluation by Experts**

To test the content validity of the package, it needs to be evaluated by experts. The subject-experts can evaluate the content with reference to objectives and multimedia experts can give suggestions about software properties.

Bruntlett (1999) has developed a set of criteria for evaluating CD-ROMs based on the criteria developed by British Educational Communications and Technology Agency (BECTA). The criteria mentioned by him are: Content, Coverage, Currency and accuracy, General applicability, Specific suitability to subject, Learning Style, Teacher or pupil resource, Appropriateness of reading, User Interface, Clarity structure and help features, Indexing and navigation, Presentation, Quality and size of images, Audio and video control and quality, Level and type of interactivity, Facilities, Support materials - what is the quality and extent of materials provided for pupils and the teacher, Technical problems encountered, Experience of use with pupils, etc.

The relevant suggestions given by experts can be considered and necessary changes can be made before the field tryout of the package.

**Reactions of learner to IMM**

Interactive multimedia is the strategy developed for learners to be used by them without interventions of instructors. It becomes very essential to find how they react to the end product. IMM, which appeals to the learners of various learning styles, individual characteristics and interests, can become effective. If the learner does not think that the content coverage, illustrations are adequate, those can be re-worked. If multimedia components are not considered as relevant, attractive, those can be edited or deleted. Activities and assessment tools can be altered if found complex, time-consuming or boring by the learners.

To collect data about each of these components, evaluation tool in the form of rating scale or opinionnaire for the learners can be developed. The tool should not contain too many items. The learners may get bored or exhausted by filling lengthy tools. The items should be specific, clear and unambiguous so that learners clearly know what and how to respond. The items should not be suggestive to get obvious responses (e.g. Were the pictures not childish? or The language was a bit difficult to understand, isn't it?).
Though the stage of evaluation of IMM is implemented only after the preparation of the package, strategies have to be planned before the task of preparation. Assessment tools and evaluation proforma can be prepared at this stage.

### Check Your Progress 14.3

**Notes:**

a) Write your answers in the space given below.

b) Compare your answers with those given at the end of this unit.

1) What are the components of a storyboard?

2) Explain the reasons for evaluation of interactive multimedia.

---

**14.8 LET US SUM UP**

Let us briefly revise contents of this module. In this unit we discussed issues related to the development of interactive multimedia packages. We first discussed characteristics, strengths and limitations of IMM packages so as to help us take decisions whether to use IMM and when. We learnt that strengths of IMM are many over the limitations and we can definitely achieve effective learning through use of IMM in many learning situations.

The IMM development is a systematic and serious effort and hence understanding of psychological bases for such developments is essential. Theories such as dual coding theory and cognitive load theory, various design principles provide us valuable guidelines for IMM development.

We also discussed process of scripting for interactive multimedia in which we discussed how to describe various multimedia elements in the storyboard. Though we discussed about various software being used for the multimedia development, one needs keep in mind that new software keep on being introduced and hence one should update knowledge about current trends before taking decision regarding software.

Evaluation of any IMM before purchase or wider use is essential. Since we have discussed several elements and principles in detail, it will be easier for you to decide criteria or refer to established standards for evaluation of multimedia.
14.9 KEYWORDS

Cognitive Load Theory postulates that more elements of experiences provided at a time may add cognitive load on the working memory of the learner.

Dual Coding Theory postulates that an human being can process verbal and visual experiences simultaneously as their working memory has two separate compartments to process these types of information.

Interactive multimedia is a multimedia which allows users to control functionalities, pace of learning, allows users to change variables, provide inputs for which the package gives feedback or else reveals further learning content.

Multimedia is an inter-woven combination of minimum two elements out of text, pictures, animations, video and sound.

Storyboard is a document describing all multimedia elements and details of their appearance, interactivities for the designer to develop multimedia.

14.10 REFERENCES AND FURTHER READINGS


Shinde, Jayashree (1994). Development of Computer Software for Learning some
14.11 FEEDBACK TO CHECK YOUR PROGRESS QUESTIONS

Check Your Progress 14.1

1) Your definition of interactive multimedia should include: multiple media feature, and interactivity, as the basic strength. We may define interactive multimedia as an integrated set of multiple media (text, audio, video, animation, and graphics) supported by hypertext-based navigational features to allow user control over the use of the multimedia. Television do provide multimedia feature, but it is not multimedia, as there is no user control.

2) Five characteristics of multimedia are:
   • Learner control
   • Interactivity
   • Multimedia elements
   • Immediate feedback
   • Provision of small chunks of information

Check Your Progress 14.2

a) True. This is in line with the contiguity principle of multimedia design.
b) False. It is against the redundancy principle of multimedia. Use of extraneous materials also adds to cognitive load.
c) True. It is in line with the segmentation principle of multimedia. Information in small chunks is easy to assimilate and understand.
d) False. Interactivity as a feature is useful in the process of feedback, and therefore, does not add to cognitive load.
e) True. Definitely more than warranted materials on a screen affect the understanding of the learners, as he/she would be focusing on materials that may not add value.
f) True. The modality principle says use more than one media, and especially recommends use audio to supplement text. This is in line with dual coding theory, as human cognition can process multiple signals at the same time.

Check Your Progress 14.3

1) Multimedia storyboard should include: textual information, relevant graphics, video, audio, animation, and navigational features for interactivity and feedback.

2) Interactive multimedia should be evaluated before use: to understand its usefulness, appropriateness, and objectivity. Evaluation of IMM also helps us to know technical problems and conceptual errors, if any, that may creep into the final product.
15.0 INTRODUCTION

Computers have the capability of two way communication, simultaneously sending and receiving information to and from other computers. This allows us to set up groups of interconnected computers sharing information. We call them a network. And networks can be connected to each other allowing, say your computer, with computers connected to these networks across the globe. This massive network of computers is what is called the Internet. So when you connect to the internet using one of the connections provided by an Internet Service Provider, your computer is connected to their network, which in turn is connected to other networks across the globe.

The World Wide Web (WWW) or the web in short, is a huge set of interlinked documents, images and other resources, riding on this network. All this digital information is typically stored on hard disks and other storage devices on each of the computers on the Internet. They are linked to each other through hyperlinks and URLs. So when you launch your browser, say Internet Explorer or Mozilla Firefox, and type in http://www.ignou.ac.in, you are requesting to view those pages which are stored on a computer accessed through this address. Each such address is known as a Uniform Resource Locator (URL), a unique address for each page on the web. You can access all those related pages clicking on links, jumping from one page to another; these links are called hyperlinks. These hyperlinks and URLs allow the web servers and other machines that store originals, and cached copies of, these resources to deliver them as required to users seeking this information. Each group of related web pages, and related resources (images, databases, etc.) accessed from a URL constitutes a website.

For the purpose of this Unit, we shall assume that you have access to a computer connected to the Internet. This is because many of the features,
applications and software, we will refer to, work on the web. Therefore, we suggest, even if you do it occasionally, you should connect to the Internet and try out these features. Further, your understanding of web technologies would depend on your critically viewing, analysing, and deconstructing a variety of websites.

15.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:

- Plan for and design a website;
- Identify tools for creation of web-pages;
- Write basic HTML tags;
- Create web-pages using HTML editors;
- Integrate media and scripts into web-pages; and
- Use simple and free CMS tools to create a website.

Please note that we distinguish between a plan and design on paper and its actual making using various tools and technologies. For this unit, we will restrict ourselves to design on paper, although you will become aware of the tools and technologies, and hopefully, inspired enough to start learning to use them.

15.2 THE WORLD WIDE WEB: AN INTEGRATED MEDIA

The web today can function as a container and disseminate a wide variety of digital information – text, pictures, audio, and video, separately or combined together. It would therefore be appropriate to refer to the web as an integrated media.

As we mentioned earlier, a thematic collection of information weaved together with a common design, and placed on a server (a computer on the Internet which serves digital content in response to a request from a client, say your computer) in the form of interlinked pages and programmes is called a website. Also, a website has a unique URL, an address which distinguishes it from other websites.

In order to view web pages, you use a software application like Internet Explorer or Mozilla Firefox. Such software applications are called browsers, because they facilitate browsing of the Internet. Browsers are designed to communicate with servers on the Internet, send and receive data, interpret and display them in a window. With the help of other software applications called plugins (they are plugged into the browser to enhance its capability), they can play audio or video files, show pictures or animations, or enable filling up and submitting of forms.

In the subsequent sections, we will design our own website with some distinct web pages. The purpose of the exercise would be to become aware of the various purposes of web based dissemination, various possibilities that the web offers and various tools and techniques available on the web to facilitate these activities.
15.2.1 Web Pages and Websites

The first step in this process is to decide what you want to say. Like any other communication, a website must also have a purpose, a theme, about which it wants to inform its visitors (or users or readers or viewers). Let us say you are fascinated by trees and wish to tell the world all about it. You will get yourself an appropriate URL like http://ourtrees.com (see section 15.4 below). Right now, you are only planning your website.

What would you like to inform your visitors about trees? Make a list of all that you want to and categorise them. Perhaps you want to tell them about individual trees. You may want to discuss different habitats and how it influences trees. You may want to talk of the produce and their uses. You may want to talk about cutting down of trees and its influence on the environment.

Obviously each category of information is distinct and will have its own separate section. Each section may even have many distinct pieces of information and may have to be put on separate pages. Say, for instance, you wish to talk of trees on mountains, trees of the plains, trees near water bodies, trees on the sea coast or trees in a desert.

You do not have to complete this task, but it would be useful if you have enough information in each of the sections and pages. Unlike a printed book, a website need not be complete before its publication. You can even add entire sections or delete them as and when you choose. In fact, most websites perennially grow, becoming more and more complex and deep.

How does your website now look? You have a main page announcing the theme and perhaps a list of the sections of the site – a kind of cover page and contents page woven together. This page is generally referred to as the Home Page (or the index page). You will realise why it is called so, shortly. Each section will have its own page or pages. As the site grows, more and more branches get added and each branch may break further into more sub-branches. A map of all these pages is called a Sitemap. Sitemaps of very large websites can be complicated indeed. Many websites have a link named ‘Sitemap’ on their homepage. Click on them and study the organisation of content on that website.

Are there different ways of organising content? Does the nature of content on your site have a bearing on the Sitemap? Organising information this way helps you structure your website. Structuring it not only helps you decide where each kind of information goes, but also helps the visitor move around your site easily.

15.2.2 Navigation

How do you browse through a printed document, say a book? You may use the contents page to locate a particular unit or sub-unit and then use page numbers to locate that particular page. You may also use the index (if there is one), select a particular keyword or concept and then use page numbers to locate that particular page. The printed book has its organisation and moving around is facilitated through the use of page numbers, index of contents or a contents page. This of course is not always the case. In some cases, like in the case of a novel, there may neither be a contents page, nor an index. The author expects you to start on page 1 and go through each page, right up to the end. Even this book has an organisation, a linear one. In the case of a properly indexed book, you can jump from one section to another at will.
The web facilitates this feature through a hyperlink. Clicking (with the left
button of your mouse) on a hyperlink takes you directly to a particular
section of the same webpage, or to another webpage or to a particular
section on the second webpage. You do not have to go to an index page to
look for the location of the keyword. While this greatly facilitates movement
around the web, it has its flip side too. Keeping track of what you clicked
and where you have landed is difficult. Many visitors get totally lost,
particularly on sites which are very deep (with many levels of pages) or with
too many hyperlinks. Facilitating the easy and rapid movement of the visitor
to desired information and come back to particular pages from where they
started is the purpose of designing a good navigation scheme.

Navigation is a feature of the organisation of your website. It helps visitors keep a
tab on where they are (on which webpage) and what is the relationship of
this page to the rest of the website. How is this achieved?

1) A simple structured sitemap: If the site has few levels of pages and
unambiguously organised into sections and sub-sections, the visitor
finds it easy to locate oneself on the website. A well structured site
allows you to come back to the first page, the home page.

2) Fewer hyperlinks: Each click on a hyperlink takes the visitor away from
the information being viewed. So, unless essential, avoid hyperlinks.
This of course would be challenging. When you have different levels of
visitors, you may find a need to explain each and every concept. If it is
only a short meaning, or example, or a definition, a small pop-up
window (or a tool tip) can be used. This helps avoid navigating away
from the page.

3) Display an index of contents: On some sites, you notice a column of
headings and sub-headings always displayed. Each time you select a
particular section, that word or phrase may get highlighted (become
bold, change colour, etc.) and the relevant page displayed on the right of
this index column. This allows you to go up and down this list, selecting
the pages you desire. Different websites use different ways of achieving
this objective.

4) Display a ‘You are Here’ sign: On some sites, you notice a sign like
home>>types of trees>>deciduous>>silk cotton somewhere at the top of the
page. Silk cotton refers to the current page. Clicking on each preceding
word will take you back one level. If you click on home, you are back on
the home page or the index page of the site. These are called
breadcrumbs and display the path from the home page to the current
page, enabling easy navigation up this branch.

Check Your Progress 15.1

Notes: a) Write your answers in the space given below.

      b) Compare your answers with those given at the end of this unit.

1) Distinguish between the Internet and the World Wide Web.
2) What are the features of a website?

............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................
............................................................................................................

15.2.3 Integrating Media

Websites can be colourful. People use graphics to enhance the design of the site, to highlight the theme of the site, or as specific examples of the information the page offers. Banners for advertising products and services are also included on sites. While some of these are still pictures (photographs, drawings, maps or graphs) some others are animations (moving graphics). One could also incorporate audio or video into the page.

Should you use graphics and animation on your site? How many and how often? What are the technological implications of media incorporated into web pages?

As we discussed in Units 11, 12 and 13, graphics, animation, audio and video are digital files. Depending on their image size and file size, these files can be very large. You may like to revise relevant sections of those units at this point. Typically a visitor to your website is connected to the Internet through a dial-up or a broadband connection, which is not always fast. Let us say the connection is clocking 50 Kbps (a file of size 50 kilo bytes will take one second to download completely onto your computer). A file of size 1 MB would take 20 seconds. How long would the graphic or audio or video take to download and play on your browser? If there are many media elements on your page, what would happen to the file size of this page? Can you account for why some websites take long to open? Compression technologies for media files or streaming servers for audio and video files, which you learnt about in Units 11, 12 and 13 could help to some extent.

Figure 15.1: Advanced Menu of Internet Explorer
If you have a slow connection to the Internet, you would like to shut off the display of graphics and animation. For instance in Internet Explorer go to Tools->Internet Options, select the Advanced Tab, and under the section titled Multimedia you will find an option called Show Pictures (See Figure 15.1). Click on the check box to remove the tick mark and click on the OK button. Now reload the web page you were looking at. Does it load faster? You will notice blank boxes where the graphics or photographs were. You could similarly shut off animation, audio, and video.

Look at this situation from the point of view of a web designer. One, if you want your visitor to access your pages fast, keep its file size small. That could mean smaller file sizes for the media (you have learnt this in Units 11, 12 and 13), smaller number of media elements and a prayer that the visitor has not shut off pictures on his/her browser. Two, distinguish between messages and decoration. See Figure 15.2, where (a) uses media elements because that is what it wants to show, e.g. this is the structure of the human brain; and (b) uses media elements, because they look nice.

![Figure 15.2: Images on a website](image)

Browsers are normally equipped to handle pictures and animations (the .GIF kind). For everything else, like flash animation, audio files and video files, browsers need installation of special software. They are installed as plugins into the browser. For instance a Quick Time player plugin is required to play quick time movies (filename.qt) or a Flash plugin to play flash or shockwave files (filename.swf). For the designer / web developer this implies selecting an appropriate technology for each kind of media. This also has implications for server capabilities (see the section 15.4 in this Unit). So, you should provide a message like “You will need Quick Time player to view the video on this page”. You may also provide a link to the website from where the visitor can download the player. Generally all media players can be downloaded free.

### 15.2.4 Static and Dynamic Websites

In order to understand the concept of static and dynamic pages and their utility, let us consider a case study. The Indian Railways (http://irctc.co.in) runs a website which allows passengers to manage their railway bookings. This site allows you, from anywhere across the world, to select a train on a particular date, and book your tickets. Even payments are made online and tickets printed on your local printer. This site uses a very important feature of web technology and significant to our understanding of communication using the web.
Let us take a specific case of ticket booking to understand this better. Let us say, a passenger logged in to this site from Tokyo, wishes to buy a ticket from Kolkata to Delhi on a particular date. He/She only has information about the locations and the date. He/She feeds in this data into a form and the website responds back with the various possible trains, availability of seats in various classes, along with the timings of the train. He/She makes his/her choice of train, fills in his/her personal details and seeks a booking. The website seeks a confirmation and passes him/her on to a payment gateway. He/She uses a credit card to pay and when the payment is confirmed the website displays his/her confirmed ticket, which he/she can print and use.

The process looks pretty straight forward. If you were a website designer you could make different pages for each of the functions of this site – one for selection of trains, one for showing availability, one for filling up personal details, and so on.

Now consider these facts. Indian Railways operates about 9,000 passenger trains and transports 18 million passengers daily across twenty-eight states and one union territory. A standard passenger train consists of eighteen coaches, but some popular trains can have up to 24 coaches. Coaches are designed to accommodate anywhere from 18 to 81 passengers, but during the holiday seasons or when on busy routes, more passengers may travel in a coach. (from http://en.wikipedia.org/wiki/Indian_Railways).

About 12,500 people are being booked each minute. And each of these passengers is seeking a ticket for any one of the 9000 trains, for any of the stations which the train goes through. And the website offers choices of different classes of travel, choice of berths, and concessions for different categories of people. Indian Railways allows you to book a ticket 60 days in advance. So, on any day, you can book a ticket for a train on any one of those 60 different dates. Further, each day, the first day is removed from the list and the 61st day added.

If each possibility were to be listed on a unique page, how many pages would have to be made? It would be almost impossible to make different web pages for each of these different possibilities. And a lot of information keeps changing. Trains are cancelled or rescheduled, new trains introduced, new stoppages introduced for trains, special trains added to cater to the rush, etc.
So, the website of Indian Railways reservation system serves thousands of different web pages (each of them distinct) to thousands of people, simultaneously. And there must be thousands of websites doing similar transactions, for example, your bank’s website, http://wikipedia.org, http://amazon.com, http://google.com. And at no time do we see such websites groaning, when you request a page. How is this feat achieved?

A beautiful piece of technology comes to the rescue. This is called Structured Query Language (SQL), a computer language for querying and modifying data and managing databases. This kind of a website consists of web pages with appropriate blank tables and a database at the back consisting of all the information, neatly organised into tables. So, when you ask, “What are the possible trains we can take to make a journey from, say, Kolkata to Delhi?” you fill up a form and press a link labelled Find Trains. This form now translates your request into an SQL query, something like, SELECT *FROM trains WHERE from_city LIKE “Kolkata” and. to_city LIKE “Delhi” echo “Train No.” echo “Train Name” echo “Station From” echo “Station To”...

Please note that this is not the exact code; it is only to indicate the complex processes that happen in the background; the exact code depends on the software platform and various other technical details.

This SQL statement is communicated to the database, which rapidly searches the table named “Trains”, under the column “Station from” for an exact match of the word “Kolkata”, filters the table such that only data which satisfy the condition “Station from” = “Kolkata” are considered. Now it searches again for an exact match under the column “Station to” = “Delhi”. Let us say this throws up six possible trains. The database then sends the results to a new webpage, having blank tables, which can display the trains (“Train No.; Train Name; Station From; Station To; Availability of train on different days of the week”)

This technology allows multiple requests of this kind to be submitted simultaneously and results of the query (different results for the different queries) sent back. As each of these web pages contains blank tables to begin with and the results are dynamically generated and displayed, we call such pages dynamic pages. And the web site therefore is a dynamic site.

As opposed to this, the site you were making http://ourtrees.com consists of pages which are already made and stored on the server. When a visitor requests a page (say, by clicking on a link), this pre-existing page is retrieved and displayed. The information sought and obtained is therefore termed static, the web page termed a static page and the web site a static site.

Look around for other examples of static and dynamic sites and study their query capabilities. Among the popular technologies which are used to create dynamic sites are Active Server Pages (ASP, ASPX), Java Server Pages (JSP), PHP Hypertext Preprocessor (PHP). You can make out the technology used by examining the URL, for example, when you make a query on http://wikipedia.org (We put in ‘dynamic site’ as the search word and clicked the button search), you will find the following URL http://en.wikipedia.org/w/index.php?title=Special:Search&search=dynamic+site&fulltext=Search; the technology used in this case is php. A similar search on http://msn.com (We put in ‘dynamic site’ as the search word) yielded the query http://search.msn.com/results.aspx?q=dynamic+site&FORM=MSNH11, which shows that the technology used in this case is aspx.


Check Your Progress 15.2

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Discuss the advantages of a dynamic website over a static one.

.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................

15.3 BEHIND THE WEB PAGES

It would be interesting to know what happens behind these web pages, which facilitates such a variety of information, rich in colours, structure, images, functionality, to be sought and displayed at the click of a button. What is requested from the server when you type in a URL into a browser or click on a hyperlink? What data travels and how is it interpreted?

Connect to the Internet, launch your browser and type in a URL of your choice. A web page corresponding to the URL you typed is displayed in your browser window. Study the page carefully. What information do you find on it? Much of the information is likely to be text. You may also find some pictures. It is also likely that you will find a form, wherein you will have to input words – like a search word or a username and password.

Now go to the View menu and select Source or right-click anywhere on the page and select Source from the pop-up menu (In Mozilla or Chrome browser, it is listed as page source). What do you see? Though at this moment it may not make any sense, this is the actual text which travels from the server to your browser, each time you seek a page. The browser reads this code and translates it into the pretty web page that you see.

Figure 15.4: The source code of a web page
15.3.1 Basic HTML Tags

First things first. The language a browser has been programmed to read is called the Hyper Text Markup Language (HTML), which as on date (in 2009) is in its fifth version (HTML5). And the codes it uses are called tags. Tags have attributes, for instance you might want your text to use Times Roman font, with a type size of 20. Tags usually come in pairs – a beginning tag and a closing tag, for example <p>OUR TREES</p>. When a browser reads this pair of tags, it will display the text in between the tags as a separate paragraph. If you see a tag beginning with <! and ending with>, the browser will interpret it as a comment and will not display it on the web page. This is useful for a web programmer to put in notes and comments about the tags used.

For rest of this section, we will familiarise you with some of these codes and discuss its power and utility. For this we would be using an editor named NVU from http://net2.com/nvu/download.html. NVU (pronounced as “N-view”) is a free, open source software program that allows you to build websites and web pages using a simple editor. We refer to editors like NVU as WYSIWYG (What You See Is What You Get), because they allow you to preview your webpages, within the editor, allowing you to fix your errors as you work.

WYSIWYG editors also help in another way. While it may be possible for us to remember many tags and even attributes, all computer codes have to be exact. Even a misplaced comma (,) or semi colon (;) can yield disastrous results. Programmers spend enormous chunks of time and professional skills locating and rectifying such faults. Using HTML editors allows us to concentrate on the functionality leaving the program to write up its own code. But as you progress to become a more advanced web developer, you will revisit the source code and tweak it.

Let us explore the use of NVU. Download the file nvu-1.0-win32-full.zip and extract it (We assume that you are using a Windows operating system on your computer. If you are using a Mac or a Linux machine, you may download the appropriate file for your system). You should find all the files in a folder called nvu-1.0PR. Open this folder and double-click on nvu.exe. And you are ready to make your web page.
The pane on the right is where you develop your page (see Figure 15.5). Observe the tabs at the bottom of this pane. These are different views of the HTML page you are constructing. The *Normal* tab shows the page as it would look in a word processor. The ‘HTML’ tab shows the page with markers indicating the HTML tags used. The ‘Source’ tab shows the HTML tags and their attributes. The ‘Preview’ tab shows the page, as it would appear in a browser – your actual web page.

Select the source tab. What do you see? These tags are the basic tags, all web pages have. You will insert the rest of the tags. Put in a title for your page, between the `<title> </title>` tags. Click on the Normal tab. You will still see a blank page. Notice that the title is visible right on top, on the window frame. This is not the heading of your page.

Now type in your text, just as you would in a word processor. Put in a heading. Using the toolbar on the top, you can highlight the text in different ways – change the colour, change the font and size of the text use bold, italic or underline. You may format the text – left or right align portions of the text, insert paragraph breaks. You may also insert an image - position your cursor on the page, select the image button from the top tool bar (or select Image from the Insert menu). Looking at the text, can you identify the highlighting or formatting you have made to the text?

Let’s continue the Ourtree.com example that we started. Suppose you have typed some content as in Figure 15.6. Now switch to the source view (click on the source tab). What do you observe? In the box below, we present a typical text with all its highlighting and formatting. We then discuss its HTML code.

![Figure 15.6: Source View in NVU](image)
So, you have created your web page. Save it as webpage.htm in a folder of your choice. Open it in a browser to check your work. If you were only trying to create a web page, then this is all that you have to do. But a website is a little more elaborate. Remember a website is a collection of pages linked to each other. The web pages may share some resources, for instance you may have a logo or menu bar, which occurs on all the pages; you may also like to organise all the documents and images in their respective folders.

Plan out your site – draw up a sitemap, which shows what pages will exist and what will be the linkages between them. You could use a word processor or even the concept mapping tool, Free Mind, that you studied in Unit 11. Create a folder which will hold all your web pages and resources. Create appropriate subfolders, for documents and images. Collect the images and other resources you will need in the appropriate folders. Now you are ready to develop your site. NVU provides a very comprehensive help document to give you step by step instructions for anything you wish to achieve. Click on Help -> Help Contents to access the help document. (See Figure 15.7).

Repeating the process you used to create a webpage, create each of your individual pages as per your site map and save them in your web folder. Test them in your browser, checking for hyperlinks, formatting, display of images, etc. Publish the pages in NVU. What remains is uploading your pages on to the web server.
Let us look at the HTML tags which helped us create this page. There are tens of other tags with very elaborate sets of attributes. But, it will not be possible for us to cover all of them here. But we will refer to some web resources (tutorials, notes and help) on HTML, which you may like to use.

**Tags used for formatting text**

- `<br>` used for creating a line break; alternately one could use a `<p> </p>` for a new paragraph. You will also notice that a closing tag `</br>` has not been produced by our HTML editor NVU. In the latest version of HTML a closing tag is preferred, although most browsers can interpret it without the closing tag.
- `<div style="text-align: center;"> </div>` used to define a block of content, particularly useful to restrict text and/or images to specific locations on the page. Notice the attribute used in this tag, “text-align: center;” used for centering text on the page; one could also use left, right, justified to position the text.
- `<span style="font-weight: bold;">`, `<span style="font-style: italic;">` or `<span style="color: rgb(255, 0, 0);">` and the closing tag `</span>` used to highlight text; the attribute style= defining what should be done with the text.

**Tags used for inserting images**

As the images are independent files – one could use images of different formats, usually jpg, gif, png – an indication of where that file resides with reference to the web page file has to be indicated. The size of the image on the web page is also specified. It is also common practice to provide an alternate text, in case the show pictures option has been shut off. This use of alternate text also serves a more important function. Persons with visual disabilities, who use screen reading software will now be able to obtain a clue to this image. Combined with other tags, images can be positioned and restricted to different locations on the web page. Instead of images, one could also insert a video or an audio file, which of course will require reference to specific players too.
<div style="text-align: center;">
<img style="width: 146px; height: 100px;" alt="Amaltas" src="http://ourtrees.com/floweringtrees/amaltas.jpg"/>
</div>

In this example, <img> tag defines the image, the style= attribute defines its size, the alt= attribute provides the alternate text and the src= attribute defines the location of the image.

**Tags used for hyperlinks**

Hyperlinks to content are one of the most significant features of a webpage. The tag should define the page or specific content on a page as the destination of the link. In our example,

```html
<a href="http://ourtrees.com/floweringtrees/amaltas.htm">click here</a>
```

the page amaltas.htm is called when you click on the link click here. It is a good practice to use the complete URL (also known as the absolute URL).

### Check Your Progress 15.3

**Notes:**

- a) Write your answer in the space given below.
- b) Compare your answer with the one given at the end of this unit.

Using appropriate examples, describe the functions of tags, attributes and values.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................

### 15.3.2 Basic Design Considerations and Accessibility Issues

How good is your website or web pages? How do we approach this question? Does a site which attracts a large number of visitors a good site? When examination results are announced, millions of students visit these sites. Does it therefore become a good site? Some web pages are beautiful to look at, like an attractively designed brochure. Does it therefore become a good site? Entire dictionaries or encyclopaedias are hosted on some site, and you can find references to almost any word or concept here. Does it therefore become a good site? You can buy almost any book that you wish at the click of a mouse from sites like http://amazon.com. Does it therefore make this site a good one?

Websites and web pages have a purpose. They may intend to communicate information to a specific category of users, say medical professionals (http://drugs.com) or to a broad category of users, like an encyclopaedia (http://britannica.com). The use of colours, images, links, organization of content, sections of the website would depend on who we are communicating to and why. Defining the purpose and identification of the target group becomes essential. A website aimed at primary school children would be organized differently from a site for adults. A website for cinema would not be organized the same way as an online course.
In any category we are bound to encounter a variety of users. Their experience of using the web, their preferences, likes and dislikes, sensory limitations, familiarity with the subject at that level, language abilities, and current concentration and anxiety levels, would all have a bearing on what the user receives. A good website is one which can simultaneously provide a uniform experience to all the users. A tall expectation indeed! But with experience and application, you will be in a position to come close to this ideal. There are a number of very good resources on the web, which provides you with information and research on the subject.

General rules applicable to the print media would apply here too. The layout, use of graphics, colour, type size, spacing, etc. would enhance readability and communication. The ease with which a user accesses information would make the experience enriching. Appropriate highlighting, organising chunks of information, supporting graphics, appropriate use of hyperlinks can help.

Most websites are accessed through search engines. That is the user requires information on some subjects, goes to sites like http://google.com puts in a keyword or phrase and selects the first or the first few links from the search results. Let us presume your website was the first listed. The user’s browser displays this site, the user scans for the word or a phrase searched for, and stays or leaves. This decision may take a few seconds to a minute. The relevance of the information on your website, and how it enables a user to go straight to what he or she is looking for will decide how long the user stays and whether he or she will visit again.

The World Wide Web has universal access to the world’s knowledge as its primary objective. And there are a large number of people who are in some ways restricted from accessing the web. Most of the web uses the roman script and communicates in English. Most of the people out there cannot read or comprehend English. Today, computer technology has enabled textual and audio-visual communication in almost every language of the world. Fonts are available and browsers capable of interpreting them (sometimes with plugins or installation of additional software). So if you have a target group which cannot understand English, then obviously your website has to be in the language they can use.

Also your users could be visually impaired (to differing degrees) or physically disabled. The spirit of the web has prompted software developers to continuously endeavour to make the web equally accessible to such people too. Screen readers, text enhancers (changing the colour, size and spacing of letters), enabling printing or copying even on to Braille, use of alternate text for images (alt text) can make websites accessible. The World Wide Web consortium (http://w3c.org) has developed very detailed guidelines for making web content accessible to different categories of users.

15.3.3 Ready-to-use Web-containers

The web has been around for over two decades and has encouraged and generated enormous creative work in computer applications. Beginning as a simple page where one could put in some text and images for others to see, the web page has now become a multipurpose two way interactive medium, handling a large variety of very complex data and computations. A variety of technologies have also been developed to handle different media.
Today, it is common place to play an interactive game, watch a video, chat with friends, and even have video conferencing using websites.

Simultaneously, this enthusiastic response to web technologies has generated a Free and Open Source Software (FOSS) movement. Millions of software enthusiasts use each other’s ideas and collaboratively develop thousands of applications, which are then given away freely to users. Software which can facilitate developing complex websites (like NVU), databases (MySQL) and web servers (Apache) which can support dynamic sites, Chat forums – one to one and many to many, News Groups, Blogs, have all been developed and made available to the web community.

What this means is that if you want to start a blog, or a discussion forum, or an online media library, you do not have to start with HTML code. Ready made web ready applications, which can be customised (modified as per your requirements) can be used to set up and host websites with very advanced features and free. Incidentally the word free here is used by the FOSS community in two ways. One, that it is being given to you without charging you for the product; and two, that the right to modify it is also yours.

One interesting application, particularly relevant to educational uses, is Content Management Systems (CMS). CMS consists of a host of related applications, which provide a ready made framework into which you can put in your content and host it as a web site. The process of updating pages and managing them are organised in such a way, that any ordinary computer user should be able to manage it. CMS also incorporate advanced interactive features like forums, blogs and wiki.

Many different CMS are available, and a large number of them are in the FOSS category. A few examples of CMS in the FOSS domain are:

- Word Press http://wordpress.org
- Joomla http://joomla.org
- Mambo http://mambo-foundation.org
- Drupal http://drupal.org
- Plone http://plone.org
- PHPNuke http://phpnuke.org
- PostNuke http://postnuke.com

As these are free – you will also find free hosts (we will deal with web hosting in section 15.4), we suggest you explore these CMS, define your web site and run them.

**Check Your Progress 15.4**

**Notes:**

a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

What are the advantages of a Content Management System?

........................................................................................................................................
........................................................................................................................................
........................................................................................................................................
........................................................................................................................................
15.4 WEB HOSTING AND DOMAIN REGISTRATION

We usually refer to a URL, a unique address for each web page; for example, http://ourtrees.com/floweringtrees/gulmohur.htm. Let us analyse this address. The phrase http:// stands for hypertext transfer protocol, a set of rules which govern the transfer of text (or other digital content like images, audio or video) between the server and client computers. The second part “ourtrees.com” is known as the domain name and is the actual address of the website. What follows the domain name, in this example, floweringtrees/gulmohur.htm refers to a file “gulmohur.htm” within a folder /floweringtrees.

The domain name itself has two parts separated by a dot (.), for example, http://about.com. In this, the latter part, i.e., com is referred to as the top-level domain name or the first level domain name. The former part, i.e., about, is referred to as the second level domain. If there are more than one part to this, as in http://parliamentofindia.nic.in, then parliamentofindia is the third level and so on.

Who assigns domain names? That in fact is another beautiful feature of the web. Nobody controls it (We discussed this in Unit 2 in this Course). You can obtain any domain name you want. In order to ensure unique assignment of names and evolve policy guidelines for the management of the Internet, a not-for-profit, public-benefit corporation called the Internet Corporation for Assigned Names and Numbers, ICANN was formed in 1998. It has participants from all over the world dedicated to keeping the Internet secure, stable and interoperable.

Given this background to naming of domains, you are ready to obtain a domain name. Various agencies have been identified as registrars of domain names. A search for domain name registration or domain name registrar or web hosting will throw up lists of thousands of companies offering web hosting and domain name registration services. If the name you choose has not already been taken, you can apply for it and for a small fee, you will become the owner of a domain name.

When you wish to set up your website, you contact a web host – a company which manages servers connected to the Internet. For a fee (there are some free hosts too), you are allowed to park your website (all the linked web pages, databases, scripts, etc.) and domain name on one of their hard disks. Once you do this, your website is up and visible to the world. Open your browser, type in http://yourtrees.com and you are looking at the home page of your website, just like any of the millions of users of the Internet would.

Some web hosts also offer packages where software applications like blogs, wikis and content management systems are pre-installed. If you wish to use one of these applications, say for instance, Joomla for your website, you will find all the relevant resources configured and ready to receive your web content.

How do you decide on the server you should select? First, the hosting plan - how much hard disk space, how much bandwidth, service support and how much does it cost. Second, the web design you have opted for – whether it is a static or dynamic sites, if it is dynamic, then the database and server page
technology (asp, jsp or php), the other plugins and server side technologies you need (for example a media server, if you want to host audio or video with streaming capabilities).

While we do not expect you launch a dynamic website with a number of complex scripts and software, it is useful to be aware of the complexities. Search for web hosting on the web and look up a few companies offering web hosting plans. Study their plans, costing, technologies and support. Also look for readymade applications like wiki, blog, and CMS. Try out your website on some of the free hosting plans. Update it, modify it, add and delete pages. You can even start your own interactive forum for your students.

### 15.5 EVALUATION OF EDUCATIONAL WEBSITES

In sub-section 15.3.2, we discussed a number of design considerations for making a good website. A well made, universally accessible, well decorated and functional website is a pleasurable experience to the visitor. But more importantly, the visitor has come to your site seeking some information and resources. Factors related to the content and its presentation also have an important role to play.

What are the factors which need to be considered to evaluate a website? Some of these are as follows:

1) **Relevance of the content**: The fine organisation of content and ensuring up to date content is very essential.

2) **Validity of the content**: The authenticity and trustworthiness of content increases visitors.

3) **Dynamic content**: Sites could host sets of Frequently Asked Questions (FAQ) or forums seeking to redress student queries. Timely and valid responses improve visitor satisfaction.

4) **Presentation of Content**: Language, typography – font, text-size, colour, positioning of text, the balance between images and text, have an effect on the visitor’s desire to stand and stare. Of course there is a fine balance between just doing it right and over doing it. While what colours and presentation style you use is strictly a personal choice, you would do well to know what your visitors desire.

5) **Hyperlinks and Navigation**: Hyperlinks can be the gateway to a rich deep website. It can also be an abyss in to which a visitor falls. Where do you use a link, what is its purpose, what happens when the user clicks on a link, how do you guide the user back, etc. will play an important role in defining and effectively using hyperlinks.

6) **User Friendliness**: A straightforward presentation with simple, intuitive navigation can make the site user friendly and help the user move around and access content on the website easily.

7) **Images**: Graphics, pictures, moving graphics, video are all possible on a website. Use them with purpose, use them with discretion, and use them to communicate.

While the above list is useful to evaluate any website, an educational website would have additional factors associated with the pedagogical slant preferred by you. If you prefer, say, an interactive forum where students discuss and debate issues under your guidance (a moderated discussion), if
you prefer, students submit assignments online and your feedback is available publicly, if you wish to provide a one-to-one tutorial support to students, then you are designing web pages which have a definite purpose and functionality. Automatically, they are then to be evaluated for how effectively they deliver on this promise.

There are a number of technological aspects of web design and programming, which has a bearing on how web sites are developed and deployed. But as these are beyond the control of a non-technical person, we have concentrated on design aspects, which an educator can modify.

Develop a check list of your web site’s features. You may then use this to obtain feedback from the visitors or a select group of users. Constantly review your site and update its design to meet your visitor’s requirements and effectively communicate your content.

Check Your Progress 15.5

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this Unit.

How do you evaluate websites?
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................

15.6 LET US SUM UP

In this unit we studied how to create website. We list a summary of the unit, below:

- The World Wide Web has evolved into a dynamic, collaborative medium with a wide range of applications, which have enormous potential for education.
- A website is a thematic collection of information and content weaved together with a common design, and placed on a server in the form of hyperlinked pages and software programmes. Each website is accessed through a unique address called its URL.
- A hyperlink is one of the most significant features of the web. It allows one to navigate from one page to another page, or a particular section of another page.
- A good navigation design helps the visitor to the website to keep tab on where they are (on which web page) and what is the relationship of this page to the rest of the website.
- Websites can contain not only text, but also images, audio and video, apart from special software which enhance the capability of web pages. Browsers may require additional plugin software to display images or play back audio and video files.
- Rich graphics can enhance the visual appeal of a site, but it also increases file size, making its access slow.
Content Creation Tools

- Websites which have to deliver a large number of customised web pages simultaneously to a large number of clients, use dynamic pages supported by databases. The web pages communicate with the database using SQL, serving responses to the queries of clients.

- Web pages use the Hypertext Markup Language (HTML) to communicate information from the server to the client. Scripts and other software programmes are used to enhance the range of functionality of web pages.

- HTML consists of tags, which are the basic codes required for formatting and displaying content. Each tag can have additional attributes, which extend its functionality.

- WYSIWYG (what you see is what you get) HTML editors help you develop web pages and organise them into websites.

- Universal Access to the world’s knowledge is the primary objective of the World Wide Web. Guidelines of design and deployment have been developed to ensure that all people, including those with disabilities, for example the blind, can also access the content on the web.

- While a web page and a website can be manually created by writing the HTML code and organising content, a number of ready made web containers are also available. Content Management Systems can facilitate the design and rapid development of websites. Some CMS can have advanced facilities like chats, blogs or wikis.

- A domain name is a unique name assigned to a website. It is of the form mywebsite.com, where \textit{com} is the top level domain and \textit{mywebsite} is the second level. Different top level domains indicate different types of websites. The assignment of domain names is governed by the International Corporation for Assigned Names and Numbers, ICANN.

- A URL is of the form http://mywebsite.com/myfolder/mypage.htm and provides the entire path and file name of each webpage.

- Placing a website on the World Wide Web involves parking a domain name, and connecting it with the index or home page of the website. The entire site consisting of the web pages and related content (images, scripts) and any specialised software and/or database is hosted (placed) on a server which is connected to the internet and hence is accessible to the public all the time.

- Criteria for the evaluation of Educational websites can be evolved based on the content, design, functionality and usage of different features of the website. Its relevance, validity, authenticity, constant updating, presentation, navigation and user friendliness can be used for rating a website.

15.7 KEYWORDS

\textbf{Content Management System:} is the collection of procedures used to manage workflow in a collaborative environment to manage files, folders, and processes in a web environment. Typical CMS includes: Joomla, Drupal, etc.

\textbf{Domain name:} is a system identification to control the use of Internet address.

\textbf{Hyperlink:} is a link on a webpage that automatically transfers the user to another page.

\textbf{URL:} is short for Universal Resource Locator, and signifies the web address of a website.

\textbf{Webpage:} is a page of information on the World Wide Web that uses Hypertext Markup Language or its variant to be accessible on the web.

\textbf{Website:} is a collection of webpage forming a distinct entity on the Web.
15.8 REFERENCES AND FURTHER READINGS


15.9 FEEDBACK TO CHECK YOUR PROGRESS

QUESTIONS

Check Your Progress 15.1

1) The Internet is a world wide network of computers connected to each other through a variety of wired and wireless communication channels. The World Wide Web, on the other hand represents the set of all webpages, linked to each other through hyperlinks.

2) Every website should have a well defined purpose, which helps select content; a well defined organisation and navigation scheme, helping an user navigate through the content easily and access the desired resources and information; a good balance between aesthetic, cosmetic, functional elements, which would result in an user staying longer at the site, without distractions.

Check Your Progress 15.2

A dynamic website responds to the queries of a user, generating webpages dynamically. Such websites are serviced by a database and a query system. From a developer’s perspective, it reduces the need to develop, maintain and modify a large number of individual pages, makes updation very easy, and ensures fewer errors and bugs. From a user perspective, it responds to a variety of information, serving thousands of pages in response to thousands of separate queries. Use an appropriate example to substantiate each of these points.

Check Your Progress 15.3

Tags are the unit of HTML code. Each tag, which occur in pairs define a function for the browser. Tags could be for structure, formatting, navigating, or managing external resources like media. Tags have attributes to extend their functionality, for example, for defining colour or font and values help control the exact nature of the attribute, for example, font="arial”

Check Your Progress 15.4

A Content Management System (CMS) is a readymade web container with a number of pre-defined functionalities. It generally has an administrative console, from which one could manage various functions of the website, upload or download content, assign roles and functions to users, and control the look and feel of the website. As all these functions are pre-built, the developer can after initial customisation, concentrate on populating and managing the content and not worry about the programming. While this relieves an advanced user from day-to-day chores of website management, it also allows a novice user to run an advanced website.

Check Your Progress 15.5

Websites have an organisation which caters to the purpose on one hand and the requirements of the user on the other. All the different features of the website will have to serve this purpose, enhancing its ability to attract and service the needs of the user. Develop a checklist which can isolate each of the features of a website and measure it. The measures could be quantitative or qualitative or both. If it is an educational website, have a separate section on the content, its organisation and the extent to which it meets the users’ needs.
Indira Gandhi National Open University

Dear Learner,

While studying the units of this block, you may have found certain portions of the text difficult to comprehend. We wish to know your difficulties and suggestions, in order to improve the course. Therefore, we request you to fill out and send us this form as soon as you complete reading this block. Kindly use a separate sheet, if you find the space provided insufficient.

Please mail to:
Course Coordinator (MDE-418)
STRIDE, IGNOU, Maidan Garhi
New Delhi – 110068, India

Questionnaire

Enrolment No. ______________________

1) How many hours did you need for studying the units?

<table>
<thead>
<tr>
<th>Unit no.</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2) In the following table we have listed 4 kinds of difficulties that we thought you might have come across. Kindly tick (√) the type of difficulty and give the relevant page number in appropriate columns.

<table>
<thead>
<tr>
<th>Page Number and Line Number</th>
<th>Presentation is not clear</th>
<th>Language is difficult</th>
<th>Diagram is not clear</th>
<th>Words/Terms are not explained</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3) It is possible that you could not attempt some CPYs. In the following table some possible difficulties are listed. Kindly tick (√) the type of difficulty and the relevant unit and question numbers in appropriate columns.

<table>
<thead>
<tr>
<th>Unit No.</th>
<th>CYP No.</th>
<th>Question Not-clearly posed</th>
<th>Type of difficulty</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Cannot answer on the basis of information</td>
<td>Answer given (at the end of unit) not clear</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4) Any other comment:-